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bị, thiết bị ....................................................................................................... III-2 

3.9      Cách khai thác sử dụng hệ thống, trang bị, thiết bị và các ứng dụng ...... III-3 



TÀI LIỆU HƯỚNG DẪN KHAI THÁC CƠ SỞ AIP  

Mục lục 

 ML-2 11/12/2023  

3.10    Quy định về phối hợp xử lý khi có hỏng hóc, trục trặc kỹ thuật ............... III-3 

Chương 4: PHƯƠNG THỨC CUNG CẤP DỊCH VỤ .................................................... IV-1 

4.1 Mô tả khu vực trách nhiệm .......................................................................... IV-1 

4.2      Đối tượng cung cấp dịch vụ ........................................................................... IV-1 

4.3 Mô tả nội dung, phương thức cung cấp dịch vụ và các quy định ............. IV-1 

4.4 Hiệp đồng/hợp đồng cung cấp dịch vụ ...................................................... IV-10 

4.5 Phương thức xử lý các trường hợp bất thường trong quá trình cung cấp 

dịch vụ .......................................................................................................... IV-10 

Chương 5: QUY TRÌNH TÁC NGHIỆP ............................................................................ V-1 

5.1 Các loại quy trình ............................................................................................ V-1 
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Chương 1 

NHỮNG QUY ĐỊNH CHUNG 

1.1 Mục đích, phạm vi, đối tượng áp dụng 

1.1.1   Mục đích 

- Tài liệu này hướng dẫn về cơ cấu tổ chức và quản lý hành chính; vị trí làm việc 

và khai thác sử dụng hệ thống, trang bị và thiết bị; phương thức cung cấp dịch 

vụ; quy trình tác nghiệp; huấn luyện và giấy phép; thống kê tổng hợp số liệu, lập 

báo cáo làm cơ sở tổ chức, khai thác Phòng AIP thuộc Trung tâm Thông báo tin 

tức hàng không - Tổng công ty Quản lý bay Việt Nam. 

- Tài liệu này hướng dẫn cho nhân viên thông báo tin tức hàng không tại Phòng 

AIP tác nghiệp (thu thập, xử lý tin tức/dữ liệu, biên soạn và phát hành) các sản 

phẩm Thông báo tin tức hàng không của Việt Nam bao gồm: Tập thông báo tin 

tức hàng không (AIP), Tập tu chỉnh AIP (AIP AMDT), Tập bổ sung AIP (AIP 

SUP), Thông tri hàng không (AIC).  

- Tài liệu này trợ giúp việc học tập, nâng cao trình độ chuyên môn, nghiệp vụ, phục 

vụ việc thi năng định hàng năm cho nhân viên thông báo tin tức hàng không của 

Phòng AIP. 

- Tài liệu này là tài liệu tham khảo cho các tổ chức, cá nhân khác có liên quan trong 

việc phối hợp, tham gia cung cấp dịch vụ Thông báo tin tức hàng không, góp 

phần đảm bảo điều hành bay an toàn, điều hoà và hiệu quả. 

1.1.2   Phạm vi và đối tượng áp dụng 

 Tài liệu này được áp dụng trong phạm vi Phòng AIP và đối tượng áp dụng là cán 

bộ, nhân viên thông báo tin tức hàng không của Phòng AIP.  

1.2 Cơ sở pháp lý và tài liệu tham chiếu 

- Luật Hàng không dân dụng Việt Nam;  

- Nghị định của Chính phủ về quản lý, khai thác cảng hàng không, sân bay; 

- Nghị định của Chính phủ quy định chi tiết về quản lý hoạt động bay; 

- Thông tư của Bộ GTVT quy định về Quản lý và bảo đảm hoạt động bay; 

- Thông tư của Bộ GTVT quy định chi tiết về quản lý, khai thác cảng hàng không, 

sân bay;   

- Thông tư của Bộ GTVT quy định về nhân viên hàng không; đào tạo, huấn luyện 

và sát hạch nhân viên hàng không; 

- Các văn bản, quyết định, hướng dẫn, TCCS của Cục Hàng không Việt Nam: 

+ Hướng dẫn về việc biên soạn Tài liệu HDKT của cơ sở ANS; 

+ Tài liệu hướng dẫn về tiêu chuẩn - Dịch vụ thông báo tin tức hàng không 

(Manuals of Standards - Aeronautical Information Services); 

+ Phương thức Quản lý tin tức hàng không (Procedures for Air Navigation Services 

- Aeronautical Information Management); 

+ Hướng dẫn xây dựng và duy trì hệ thống quản lý chất lượng - dịch vụ thông báo 

tin tức hàng không/quản lý tin tức hàng không (AIS/AIM); 

+ Quyết định về việc công nhận Huấn luyện viên bảo đảm hoạt động bay; 
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- Thỏa ước lao động tập thể giữa Ông Tổng giám đốc Tổng công ty Quản lý bay 

Việt Nam và người đại diện cho tập thể người lao động; 

- Quyết định của Tổng công ty Quản lý bay Việt Nam về Nội quy lao động; 

- Quyết định của Trung tâm Thông báo tin tức hàng không về việc sửa đổi, bổ sung 

Quy chế công tác văn thư, lưu trữ; 

- Quyết định của Giám đốc Trung tâm Thông báo tin tức hàng không về việc ban 

hành Quy định chức năng, nhiệm vụ, quyền hạn và cơ cấu tổ chức các Phòng, 

Trung tâm thuộc Trung tâm Thông báo tin tức hàng không; 

- Quy định của Trưởng phòng AIP về việc phân công thực hiện nhiệm vụ của cán 

bộ, nhân viên, bộ phận Phòng AIP; 

- Các Phụ ước ICAO:  

+ Phụ ước 1: Cấp giấy phép nhân viên; 

+ Phụ ước 2: Quy tắc bay; 

+ Phụ ước 4: Sơ đồ hàng không; 

+ Phụ ước 5: Đơn vị đo lường sử dụng trong khai thác hoạt động bay dân dụng; 

+ Phụ ước 10: Thông tin hàng không; 

+ Phụ ước 11: Dịch vụ không lưu; 

+ Phụ ước 14: Sân bay; 

+ Phụ ước 15: Dịch vụ thông báo tin tức hàng không; 

+ Phụ ước 19: Quản lý an toàn. 

- Các tài liệu (Doc) ICAO: 

+ Tài liệu 4444: Quản lý không lưu; 

+ Tài liệu 7383: Tài liệu về dịch vụ thông báo tin tức hàng không của các quốc gia; 

+ Tài liệu 7910: Các chỉ địa danh hàng không; 

+ Tài liệu 8126: Tài liệu về dịch vụ thông báo tin tức hàng không; 

+ Tài liệu 8400: Các chữ viết tắt và mã của ICAO; 

+ Tài liệu 8585: Tên các nhà khai thác tàu bay, nhà chức trách và các cơ quan hàng 

không; 

+ Tài liệu 8643: Ký hiệu loại tàu bay; 

+ Tài liệu 8697: Tài liệu về sơ đồ hàng không; 

+ Tài liệu 10066: Quản lý tin tức hàng không. 

1.3  Quy ước viết tắt  

Trong Tài liệu này, các chữ viết tắt dưới đây được diễn giải như sau: 

Chữ tắt Tiếng Anh Tiếng Việt 

AD Aerodrome Sân bay 

AIC Aeronautical Information 

Circular 

Thông tri hàng không 

AIM Aeronautical Information 

Management 

Quản lý tin tức hàng không 

AIP Aeronautical Information 

Publication 

Tập thông báo tin tức hàng không 
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Chữ tắt Tiếng Anh Tiếng Việt 

AIP AMDT AIP Amendment Tập tu chỉnh AIP 

AIP SUP AIP Supplement Tập bổ sung AIP 

AIRAC Aeronautical Information 

Regulation and Control 

Hệ thống kiểm soát và điều chỉnh tin tức 

hàng không 

AIRAC AIP 

AMDT 

AIRAC AIP Amendment Tập tu chỉnh AIP theo chu kỳ AIRAC 

AIRAC AIP 

SUP 

AIRAC AIP Supplement Tập bổ sung AIP theo chu kỳ AIRAC 

AIS Aeronautical Information 

Service 

Dịch vụ thông báo tin tức hàng không 

AIXM Aeronautical Information 

Exchange Model 

Mô hình trao đổi tin tức hàng không 

ATS Air Traffic Services Dịch vụ không lưu 

CADAS COMSOFT Aeronautical 

Data Access System 

Hệ thống truy cập dữ liệu hàng không 

của Comsoft 

CADAS ATS CADAS Air Traffic 

Services 

Hệ thống truy cập dữ liệu hàng không 

của Comsoft - Dịch vụ không lưu  

CADAS IMS CADAS Information 

Management and Services 

Hệ thống truy cập dữ liệu hàng không 

của Comsoft - Quản lý tin tức và các 

dịch vụ 

Cục HKVN  Cục Hàng không Việt Nam 

COM Communication Thông tin 

CSDL Data base Cơ sở dữ liệu 

CR Change Request Yêu cầu thay đổi 

Doc. Document Tài liệu 

eAIC Electronic Aeronautical 

Information Circular 

Thông tri hàng không điện tử 

eAIP Electronic Aeronautical 

Information Publication 

Tập TBTTHK điện tử 

eAMDT Electronic AIP 

Amendment 

Tập tu chỉnh AIP điện tử 

eSUP Electronic AIP 

Supplement 

Tập bổ sung AIP điện tử 

FIR Flight Information Region Vùng thông báo bay 

GEN General Tổng quát 

HDKT  Hướng dẫn khai thác 

Hệ thống AIS 

tự động 

Automated AIS System Hệ thống Thông báo tin tức hàng không 

tự động 

Hệ thống AIM  Hệ thống Quản lý tin tức hàng không 

HK  Hàng không 

HKDD  Hàng không dân dụng 

HKVN  Hàng không Việt Nam 

HTML HyperText Markup 

Language 

Ngôn ngữ đánh dấu siêu văn bản (để tạo 

các trang web và các tin tức khác có thể 

được hiển thị trên trình duyệt web) 
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Chữ tắt Tiếng Anh Tiếng Việt 

ICAO International Civil 

Aviation Organization 

Tổ chức HKDD quốc tế 

KHB  Kế hoạch bay 

MET Meteorology Khí tượng 

NOF International NOTAM 

Office 

Phòng NOTAM quốc tế 

NOTAM Notice to Airmen Điện văn thông báo hàng không 

PDF Portable Document 

Format 

Định dạng tài liệu linh hoạt 

PERM Permanent Lâu dài 

PIB Pre-flight Information 

Bulletin 

Bản thông báo tin tức trước chuyến bay 

SAR Search and Rescue Tìm kiếm và cứu nạn 

SDO Static Data Operations Khai thác dữ liệu tĩnh 

TBTTHK  Thông báo tin tức hàng không 

TCT  Tổng công ty 

TCTQLBVN  Tổng công ty Quản lý bay Việt Nam 

TTHK  Tin tức hàng không 

UTC Universal Time 

Coordination 

Giờ quốc tế 

VNAIC Viet Nam Aeronautical 

Information Centre 

Trung tâm Thông báo tin tức hàng 

không (Trung tâm) 

XML Extensible Markup 

Language 

Ngôn ngữ đánh dấu mở rộng 

1.4  Giải thích thuật ngữ  

Trong Tài liệu này, các thuật ngữ dưới đây được hiểu như sau: 

 

Thuật ngữ Tiếng Anh Giải thích 

Bản danh mục 

NOTAM còn 

hiệu lực 

Checklist of valid 

NOTAM 

Là danh mục các NOTAM còn hiệu lực 

được phát hành hàng tháng. 

Bản đồ, sơ đồ 

hàng không 

Aeronautical maps and 

charts 

Là bản đồ, sơ đồ bao gồm các tin tức hàng 

không cần thiết để người lái, các tổ chức 

và cá nhân liên quan đến hoạt động bay 

sử dụng. 

Bản thông báo 

tin tức trước 

chuyến bay 

Pre-flight information 

bulletin (PIB) 

Là bản thông báo gồm các NOTAM còn 

hiệu lực có tính chất khai thác quan trọng 

ảnh hưởng đến hoạt động bay, được 

chuẩn bị để cung cấp cho tổ lái trước 

chuyến bay. 

 

Bảng kiểm tra 

danh mục các 

trang AIP 

Checklist of AIP pages Là các trang GEN 0.4 trong AIP có đánh 

dấu những trang mới trong tu chỉnh mới 

nhất, qua đó người khai thác dễ nhận biết 
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Thuật ngữ Tiếng Anh Giải thích 

được các trang mới và giúp cho việc cập 

nhật tài liệu được thuận lợi. 

Cơ sở CSDLHK  Cơ sở Cơ sở dữ liệu hàng không 

Dịch vụ 

TBTTHK 

Aeronautical Information 

Services 

Là dịch vụ được thiết lập trong phạm vi 

khu vực trách nhiệm nhất định để cung 

cấp dữ liệu HK và TTHK cần thiết đảm 

bảo an toàn, điều hòa và hiệu quả của hoạt 

động bay 

Điện văn thông 

báo HK 

NOTAM Là thông báo được phát hành bằng 

phương tiện viễn thông liên quan đến việc 

thiết lập, tình trạng hoặc sự thay đổi của 

phương tiện dẫn đường, dịch vụ, phương 

thức hoặc sự nguy hiểm mang tính quan 

trọng mà tổ lái và những người có liên 

quan đến hoạt động bay cần phải nhận 

biết kịp thời để xử lý. 

Hệ thống AIS tự 

động 

Automated AIS System Là hệ thống gồm phần cứng và phần mềm 

có mã nguồn mở để cung cấp dịch vụ 

TBTTHK tự động. Hệ thống gồm các ứng 

dụng như: 

- CADAS-ATS; 

- CADAS-IMS; 

- AIP; 

- Documentation Service; 

- Map/Chart. 

Kiểm soát và 

điều chỉnh 

TTHK 

Aeronautical Information 

Regulation and 

Control(AIRAC) 

Là hệ thống thông báo trước về những 

thay đổi quan trọng ảnh hưởng trực tiếp 

đến hoạt động bay, căn cứ vào những 

ngày có hiệu lực chung do Tổ chức hàng 

không dân dụng quốc tế quy định. 

Ngày có hiệu 

lực 

Effective date Là ngày hiệu lực của tin tức. 

Ngày phát hành Publication date Là ngày tin tức được phát hành. 

NOTAM nhắc 

lại 

Trigger NOTAM Là NOTAM nhắc nhở người khai thác về 

thông tin khai thác quan trọng đã được 

phổ biến trong Tập tu chỉnh AIP hoặc Tập 

bổ sung AIP theo chu kỳ AIRAC. 

Quản lý tin tức 

hàng không 

Aeronautical Information 

Management (AIM) 

Là việc quản lý theo thể năng động và tích 

hợp các tin tức HK thông qua việc phối 

hợp cung cấp, trao đổi dữ liệu HK dạng 

số được đảm bảo chất lượng với các bên 

liên quan 

Sản phẩm tin 

tức hàng không  

Aeronautical information 

product 

Là dữ liệu hàng không và tin tức hàng 

không được cung cấp dưới dạng bộ dữ 

liệu số hoặc dưới dạng bản giấy hoặc bản 

điện tử được chuẩn hóa, bao gồm: 
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Thuật ngữ Tiếng Anh Giải thích 

- Tập thông báo tin tức hàng không (AIP), 

bao gồm Tập tu chỉnh và các Tập bổ sung 

AIP; 

- Thông tri hàng không (AIC); 

- Sơ đồ hàng không; 

- NOTAM; 

- Bộ dữ liệu số. 

Tập bổ sung 

AIP 

AIP Supplement 

 

Là tài liệu chứa đựng những thay đổi 

mang tính chất tạm thời đối với những tin 

tức trong AIP và được phát hành bằng 

những trang đặc biệt. 

Tập TBTTHK - 

AIP 

Aeronautical Information 

Publication 

Là tài liệu TTHK, bao gồm những tin tức 

ổn định lâu dài, cần thiết cho hoạt động 

bay. 

Tập tu chỉnh 

AIP 

AIP Amendment  Là tài liệu chứa đựng những thay đổi 

mang tính chất lâu dài đối với những tin 

tức trong AIP. 

Thông tri hàng 

không 

Aeronautical Information 

Circular  

Là bản thông báo gồm những tin tức liên 

quan đến an toàn bay, dẫn đường, kỹ 

thuật, hành chính, pháp luật mà những tin 

tức đó không phù hợp phổ biến bằng 

NOTAM hoặc AIP SUP. 

TTHK Aeronautical Information Là tin tức thu được từ quá trình tổng hợp, 

phân tích và định dạng dữ liệu HK. 

Ứng dụng 

Wiz@rd Suite 

 Là một ứng dụng của Hệ thống AIM có 

chức năng: 

- Quản lý dữ liệu tĩnh (AIXM 5.1); 

- Biên soạn các sản phẩm AIP/eAIP, AIP 

AMDT, AIP SUP, AIC; 

- Sản xuất sơ đồ ICAO và các sơ đồ khác 

và các sản phẩm khác; 

Hỗ trợ người sử dụng trong luồng công 

việc nhận, đánh giá, xử lý và phát hành 

dữ liệu/tin tức hàng không. 

Hỗ trợ trong quy trình ADQ/QMS tự 

động. 

Ứng dụng 

eAIP.wiz@rd 

 Là một ứng dụng con trong ứng dụng 

chính Wiz@rd Suite của Hệ thống AIM, 

có tính năng: 

- Quản lý luồng công việc; 

- Quản lý dữ liệu; 

- Quản lý sự thay đổi; 

- Tạo tài liệu; 

- Quản lý tài liệu; 

- Hỗ trợ đa ngôn ngữ; 

- Quản lý NOTAM. 
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1.5 Các quy định chung khác 

1.5.1 Phân cấp quản lý 

- Trung tâm TBTTHK là đơn vị trực tiếp quản lý Phòng AIP. 

- Đơn vị quản lý cấp trên: Tổng công ty Quản lý bay Việt Nam. 

1.5.2 Trách nhiệm tu chỉnh tài liệu 

- Tài liệu hướng dẫn khai thác (HDKT) này được xem xét tu chỉnh định kỳ 2 

lần/năm vào tháng 5 và tháng 11 hàng năm; tu chỉnh đột xuất khi cần thiết. 

- Trưởng phòng AIP có trách nhiệm thường xuyên rà soát, cập nhật; đề xuất các 

nội dung sửa đổi, bổ sung Tài liệu HDKT này; báo cáo Lãnh đạo Trung tâm làm 

thủ tục theo quy định của Tổng công ty Quản lý bay Việt Nam trình Cục Hàng 

không Việt Nam phê duyệt. 
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Chương 2 

CƠ CẤU TỔ CHỨC VÀ QUẢN LÝ HÀNH CHÍNH 

Mục 1 

CƠ CẤU TỔ CHỨC 

2.1 Cơ cấu tổ chức của cơ sở 

Cơ cấu tổ chức của Phòng AIP gồm:  

- Trưởng phòng; 

- Các Phó Trưởng phòng; 

- Phụ trách các bộ phận Sản phẩm/Ấn phẩm và Dữ liệu;  

- Các nhân viên liên quan; và 

- Các huấn luyện viên AIP. 

2.2 Trách nhiệm, quyền hạn của cơ sở 

Phòng AIP là đơn vị chịu trách nhiệm biên soạn và phát hành, trao đổi, bán và 

cấp phát các sản phẩm TBTTHK. 

- Phối hợp với Cơ sở CSDLHK kiểm tra, đối chiếu dữ liệu HK và tin tức HK nhận 

được. 

- Biên soạn phần chữ các sản phẩm TBTTHK của Việt Nam: Tập AIP Việt Nam, 

Tu chỉnh AIP, Tập bổ sung AIP, Thông tri hàng không (theo CR đã khởi tạo của 

Cơ sở CSDLHK).  

- Chủ trì thực hiện các thủ tục trình phê duyệt sản phẩm; phối hợp in ấn, đăng tải, 

phát hành sản phẩm và thống kê, báo cáo số lượng sản phẩm biên soạn, phát hành 

theo quy định. 

- Thực hiện việc trao đổi, bán, cấp phát các sản phẩm TBTTHK của Việt Nam theo 

phê duyệt của cấp có thẩm quyền; quản lý thông tin chi tiết liên quan đến khách 

hàng bán, trao đổi, cấp phát. 

- Phối hợp cấp, quản lý tài khoản truy cập sản phẩm TBTTHK của Việt Nam trên 

trang thông tin điện tử của Trung tâm và tài khoản RAIM theo phê duyệt. 

- Chủ trì, đề xuất trao đổi, cập nhật, lưu trữ các sản phẩm TBTTHK nước ngoài. 

- Đề xuất sửa đổi, bổ sung và biên soạn tài liệu HDKT cơ sở. 

- Nghiên cứu, xây dựng, đóng góp, sửa đổi các văn bản quy phạm pháp luật liên 

quan đến lĩnh vực TBTTHK (khi được yêu cầu). 

- Sử dụng các trang thiết bị, tài sản và các nguồn lực được giao để thực hiện nhiệm 

vụ; 

- Quản lý, bố trí, sử dụng, thực hiện đào tạo - huấn luyện, đề xuất khen thưởng - 

kỷ luật đối với nguồn lực lao động theo phân cấp; 

- Tham gia các hội nghị, hội thảo trong nước và quốc tế liên quan đến chuyên môn, 

nhiệm vụ được giao; 

- Tham gia đào tạo, huấn luyện để nâng cao trình độ chuyên môn nghiệp vụ và đáp 

ứng các yêu cầu thực hiện nhiệm vụ mới; 

- Tham gia các chương trình nghiên cứu khoa học, phát triển thuộc các lĩnh vực 

liên quan chuyên ngành AIS (nếu có); 
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- Đề xuất mua sắm, đầu tư trang thiết bị, công cụ, dụng cụ lao động để thực hiện 

nhiệm vụ được giao; 

- Tham gia xây dựng kế hoạch hàng năm của Phòng AIP và Trung tâm TBTTHK; 

- Chủ động phối hợp với các tổ chức, cá nhân trong và ngoài Trung tâm TBTTHK 

để thực hiện nhiệm vụ được giao theo quy định. 

2.3  Nguyên tắc làm việc 

- Cán bộ, phụ trách bộ phận và nhân viên (CBNV) Phòng AIP thực hiện nhiệm vụ 

theo phân công. Ngoài ra, CBNV Phòng AIP có thể thực hiện các nhiệm vụ đột 

xuất khác theo yêu cầu công việc.; 

- Trong quá trình thực hiện nhiệm vụ, CBNV Phòng AIP có trách nhiệm tuân thủ 

các văn bản quy định của Cục HKVN, TCTQLBVN, Trung tâm TBTTHK và 

Phòng AIP; 

- Mỗi CBNV, phụ trách bộ phận trong phòng phải nỗ lực hết mình để hoàn thành 

tốt nhiệm vụ được giao. Trong một số trường hợp (nếu cần) có thể đề nghị sự hỗ 

trợ, giúp đỡ từ CBNV khác trong Phòng để hoàn thành nhiệm vụ đúng tiến độ, 

đảm bảo chất lượng. 

2.4   Nguyên tắc phối hợp 

- Phối hợp nội bộ phòng: Mỗi CBNV trong Phòng phải thường xuyên trao đổi, 

phối hợp với nhau khi thực hiện nhiệm vụ được giao; 

- Phối hợp trong Trung tâm TBTTHK: Việc phối hợp với các phòng trong Trung 

tâm được thực hiện theo Tài liệu hướng dẫn khai thác, các quy trình và các văn 

bản quản lý nội bộ của Trung tâm; 

- Phối hợp với các cơ quan, đơn vị ngoài Trung tâm TBTTHK: Khi cần phối hợp 

với các cơ quan, đơn vị ngoài Trung tâm (Ban Không lưu, Cục HKVN, các cảng 

hàng không, sân bay, các cơ quan quân sự v.v) để biên soạn và phát hành sản 

phẩm TBTTHK, cán bộ Phòng được giao nhiệm vụ có trách nhiệm chủ trì thực 

hiện việc phối hợp. 

2.5 Trách nhiệm, quyền hạn của Trưởng/Phó Trưởng cơ sở 

2.5.1 Trách nhiệm, quyền hạn của Trưởng cơ sở (Trưởng phòng) 

- Trưởng phòng là người quản lý, điều hành mọi hoạt động của Phòng AIP. Chịu 

trách nhiệm về việc thực hiện nhiệm vụ chuyên môn của phòng trước Ban Giám 

đốc Trung tâm; 

- Chủ trì lập kế hoạch công tác năm, quý, tháng của phòng và chỉ đạo triển khai 

thực hiện trong toàn phòng; 

- Phân công, bố trí cho các Phó Trưởng phòng, nhân viên, bộ phận trong phòng 

đảm nhận công việc phù hợp với năng lực, trình độ, tiêu chuẩn chức danh; 

- Thi hành các biện pháp quản lý nhằm nâng cao chất lượng, lề lối, tác phong làm 

việc; 

- Thực hiện các nhiệm vụ khác do Ban Giám đốc Trung tâm giao. 

2.5.2 Trách nhiệm, quyền hạn của Phó Trưởng cơ sở (Phó Trưởng phòng) 
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- Các Phó Trưởng phòng thực hiện các nhiệm vụ khi được Trưởng phòng hoặc Ban 

Giám đốc Trung tâm giao; 

- Trên cơ sở các nhiệm vụ được giao đảm nhiệm, các Phó Trưởng phòng có trách 

nhiệm trực tiếp thực hiện hoặc tổ chức, chỉ đạo, đôn đốc các phụ trách bộ phận, 

nhân viên trong phòng thực hiện nhiệm vụ được giao; 

- Thực hiện công tác kiểm tra, đối chiếu, thẩm định nội dung sản phẩm trước khi 

trình cơ quan có thẩm quyền phê duyệt (Tổng công ty Quản lý bay Việt Nam, 

Cục Hàng không Việt Nam); 

- Có trách nhiệm chủ trì thực hiện việc phối hợp với các cơ quan, đơn vị ngoài 

Trung tâm (Ban Không lưu, Cục HKVN, các cảng hàng không, sân bay, các cơ 

quan quân sự v.v) để biên soạn và phát hành sản phẩm TBTTHK; 

- Xây dựng chương trình, kế hoạch huấn luyện, tham gia hướng dẫn ôn tập, giảng 

dạy các khóa huấn luyện thi nâng bậc, cấp giấy phép nhân viên hàng không, cấp 

mới/gia hạn năng định cho nhân viên AIS; 

- Phụ trách công tác Quản lý an toàn - Chất lượng của phòng; 

- Phó Trưởng phòng được ủy quyền thay mặt Trưởng phòng phụ trách phòng trong 

thời gian Trưởng phòng vắng mặt và có trách nhiệm thực hiện các nhiệm vụ như 

Trưởng phòng và chịu trách nhiệm hoàn toàn về quyết định của mình trước 

Trưởng phòng và Ban Giám đốc Trung tâm. 

2.6  Trách nhiệm, quyền hạn của Phụ trách bộ phận 

- Thực hiện các nhiệm vụ khi được Trưởng phòng/Phó Trưởng phòng/Ban Giám 

đốc Trung tâm giao; 

- Thực hiện công tác biên soạn sản phẩm TBTTHK (AIP, AIP SUP, AIC); 

- Thực hiện công tác phối hợp với Cơ sở CSDLHK về các mốc thời gian, không 

gian làm việc (Workspace) được chỉ định trên hệ thống AIM để phát hành sản 

phẩm. 

- Phân công, đôn đốc các nhân viên để hoàn thành nhiệm vụ. Trong khi thực hiện 

nhiệm vụ, nếu có khó khăn, vướng mắc ngoài khả năng hoặc phạm vi trách nhiệm, 

cần báo cáo với cán bộ phòng phụ trách/chủ trì nhiệm vụ để đề xuất phương án 

hoặc biện pháp giải quyết. 

- Báo cáo tiến độ thực hiện công việc và các tình huống phát sinh cho Phó Trưởng 

phòng phụ trách/chủ trì hoặc Trưởng phòng; 

- Tuân thủ nghiêm túc các nguyên tắc làm việc, phối hợp làm việc trong và ngoài 

đơn vị. 

- Thực hiện công tác phối hợp ngoài Trung tâm (Ban Không lưu, Cục HKVN, cảng 

HKSB…): nếu được cán bộ phòng phụ trách (có trách nhiệm chủ trì nhiệm vụ 

đó)/Trưởng phòng phân công. 
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2.7 Yêu cầu về năng lực, trách nhiệm, quyền hạn của nhân viên 

2.7.1  Nhân viên Biên soạn sản phẩm   

- Thu thập kiểm tra và xử lý các dữ liệu/tin tức hàng không liên quan, phối hợp với 

các cơ quan đơn vị liên quan để kiểm tra dữ liệu/tin tức hàng không (người khởi 

tạo dữ liệu theo văn bản hiệp đồng/văn bản thỏa thuận cung cấp dữ liệu/tin tức 

HK, các cơ quan chuyên môn thuộc Cục HKVN, VATM, và các cơ quan, đơn vị 

khác); soạn thảo (biên soạn, biên tập, biên dịch), phối hợp với Cơ sở CSDLHK, 

Phòng BĐPTB, Phòng NOF để hoàn thiện sản phẩm; làm thủ tục trình phê duyệt 

các sản phẩm TBTTHK bao gồm: AIP, Tập tu chỉnh AIP, Tập bổ sung AIP,  AIC; 

- Khai thác đầu cuối AIP thuộc Hệ thống AIM; 

- Xuất bản/phát hành, cung cấp, trao đổi, mua bán và cấp phát các sản phẩm 

TBTTHK;  

- Nghiên cứu nội dung các sản phẩm TBTTHK nước ngoài, phân loại, báo cáo các 

nội dung quan trọng liên quan đến hoạt động bay cho lãnh đạo Phòng, lựa chọn 

những sản phẩm có nội dung liên quan trực tiếp đến khai thác bay để gửi cho các 

cơ sở tham gia cung cấp dịch vụ TBTTHK và các cơ quan, đơn vị có liên quan 

đến hoạt động bay; 

- Thực hiện công tác báo cáo theo quy định;  

- Thực hiện các nhiệm vụ khác liên quan đến các hoạt động TBTTHK khi được 

phân công. 

2.7.2 Nhân viên Quản lý và phát hành sản phẩm   

- Thu thập, xử lý các dữ liệu/tin tức hàng không;  

- Khai thác các đầu cuối AIP thuộc Hệ thống AIM; đăng tải sản phẩm, tài liệu 

TBTTHK trên website AIS; phối hợp khai thác các ứng dụng khác của Hệ thống 

AIM; 

- Thực hiện cập nhật định kỳ các tài liệu nghiệp vụ và tài liệu tham khảo về dịch 

vụ TBTTHK cho các phòng thuộc Trung tâm; lưu trữ tài liệu theo quy định; 

- Nghiên cứu, xây dựng, đóng góp, sửa đổi các văn bản quy phạm pháp luật liên 

quan đến lĩnh vực TBTTHK; 

- Tham gia biên soạn các văn bản quản lý nội bộ, tài liệu hướng dẫn khai thác của 

phòng; tham gia biên soạn tài liệu nghiệp vụ, tài liệu hướng dẫn khai thác hệ 

thống trang thiết bị và tài liệu liên quan khác; 

- Dự thảo, quản lý và cập nhật các văn bản hiệp đồng bảo đảm cung cấp dịch vụ 

TBTTHK; 

- Thực hiện các nhiệm vụ khác liên quan đến các hoạt động TBTTHK khi được 

phân công. 

2.7.3 Yêu cầu về trình độ chuyên môn của nhân viên biên soạn sản phẩm   

- Có giấy phép, năng định nhân viên AIP còn hiệu lực;  
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- Có kiến thức chung về hàng không dân dụng: Cơ cấu tổ chức ngành, luật lệ hàng 

không, an ninh, an toàn; hệ thống văn bản quy phạm pháp luật liên quan đến lĩnh 

vực TBTTHK; 

- Có kiến thức chung liên quan đến chuyên ngành Thông báo tin tức hàng không: 

Dịch vụ Không lưu; Dịch vụ Khí tượng hàng không; Dịch vụ thông tin, dẫn 

đường, giám sát; Dịch vụ tìm kiếm cứu nạn; Cảng hàng không, sân bay; tàu bay; 

dẫn đường;  

- Có kiến thức về AIS/AIM (dịch vụ TBTTHK/QLTTHK); các loại dữ liệu/tin tức; 

phát hành tin tức; các sản phẩm của dịch vụ TBTTHK; hệ thống văn bản tài liệu; 

hệ thống trang thiết bị bảo đảm cung cấp dịch vụ; hệ thống quản lý chất lượng và 

các quy trình, quy định liên quan; 

- Hiểu biết về các sản phẩm TBTTHK, quy trình xử lý, biên soạn, phát hành và lưu 

trữ tin tức, sản phẩm; 

- Có kiến thức về tiếng Anh chung và tiếng Anh chuyên ngành hàng không và đáp 

ứng trình độ tiếng Anh theo quy định; 

- Được huấn luyện định kỳ, huấn luyện nâng cao, huấn luyện phục hồi theo quy 

định. 

- Hiểu biết về năng lực cá nhân (human performance). 

2.7.3 Yêu cầu về trình độ chuyên môn của nhân viên quản lý và phát hành sản phẩm   

- Có giấy phép, năng định nhân viên AIP còn hiệu lực;  

- Có kiến thức chung về hàng không dân dụng: cơ cấu tổ chức ngành, luật lệ hàng 

không, an ninh, an toàn, hệ thống văn bản quy phạm pháp luật liên quan đến lĩnh 

vực TBTTHK; 

- Có kiến thức chung liên quan đến chuyên ngành Thông báo tin tức hàng không: 

Dịch vụ Không lưu; Dịch vụ Khí tượng hàng không; Dịch vụ thông tin, dẫn 

đường, giám sát; Dịch vụ tìm kiếm cứu nạn; Cảng hàng không, sân bay; tàu bay; 

dẫn đường;  

- Có kiến thức về AIS/AIM (dịch vụ TBTTHK/QLTTHK); các loại dữ liệu/tin tức; 

phát hành tin tức; các sản phẩm của dịch vụ TBTTHK; hệ thống trang thiết bị 

bảo đảm cung cấp dịch vụ; hệ thống quản lý chất lượng và các quy trình, quy 

định liên quan; 

- Có kiến thức về tiếng Anh chung và tiếng Anh chuyên ngành hàng không và đáp 

ứng trình độ tiếng Anh theo quy định;; 

- Hiểu biết về cơ sở dữ liệu hàng không;  

- Hiểu biết các văn bản quản lý nội bộ, tài liệu nghiệp vụ và tài liệu tham khảo, tài 

liệu hướng dẫn khai thác, các văn bản hiệp đồng bảo đảm cung cấp dịch vụ; 

- Được huấn luyện định kỳ, huấn luyện nâng cao, huấn luyện phục hồi theo quy 

định. 

- Hiểu biết về năng lực cá nhân (human performance). 
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2.8 Trách nhiệm, quyền hạn của huấn luyện viên kiêm nhiệm 

- Chịu sự quản lý và phân công trực tiếp của Trưởng phòng trong việc thực hiện 

nhiệm vụ được phân công theo từng mảng chuyên đề của các khóa huấn luyện cụ 

thể; 

- Chuẩn bị nội dung, giáo trình, giáo án lên lớp giảng dạy, các tài liệu tham khảo 

và tham chiếu sử dụng đúng với mục đích của khóa huấn luyện được cấp có thẩm 

quyền phê duyệt; 

- Kiểm tra, đánh giá, nhận xét đối với từng học viên khi kết thúc môn học, tổng 

hợp báo cáo kết quả chung và lưu trữ kết quả huấn luyện theo quy định; 

- Thực hiện khóa huấn luyện theo chương trình và thời gian quy định; 

- Tham gia đóng góp, xây dựng tài liệu huấn luyện khai thác đảm bảo cập nhật 

nhất các kiến thức chuyên môn mà đối tượng lao động trực tiếp cần được trang 

bị kịp thời, phù hợp với điều kiện khai thác thực tế. 
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Mục 2 

LƯU TRỮ VĂN BẢN TÀI LIỆU 

2.9 Danh mục văn bản tài liệu lưu trữ  

Thực hiện theo “Hướng dẫn việc lập, quản lý và cập nhật hệ thống văn bản, tài 

liệu nghiệp vụ của cơ sở cung cấp dịch vụ bảo đảm hoạt động bay”. 

2.10 Chế độ, vị trí, người lưu trữ 

2.10.1 Chế độ lưu trữ 

Tài liệu được lưu trữ gọn gàng, ngăn nắp; sắp xếp có khoa học, đảm bảo cán bộ 

nhân viên có thể truy cập và sử dụng phiên bản mới nhất, bằng 2 hình thức: 

- Bản giấy (lưu các bản in hoặc sao chụp); 

- Bản điện tử. 

2.10.2 Vị trí lưu trữ 

- Tài liệu bản giấy lưu tại Phòng AIP; 

- Tài liệu bản điện tử lưu trên máy tính, mạng nội bộ của phòng và đầu cuối AIP 

(Hệ thống AIM). 

2.10.3 Người lưu trữ 

Trưởng phòng AIP phân công người lưu trữ theo Bảng phân công công việc 

Phòng AIP. 

2.11 Chế độ kiểm tra 

- Phụ trách bộ phận Dữ liệu kiểm tra sau khi tài liệu lưu trữ được bổ sung, tu chỉnh 

hoặc cập nhật và báo cáo kết quả kiểm tra cho Trưởng phòng; 

- Tài liệu lưu trữ được kiểm tra vào các kỳ kiểm tra an toàn, đánh giá hệ thống 

quản lý chất lượng của Trung tâm. 
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Chương 3 

VỊ TRÍ LÀM VIỆC VÀ KHAI THÁC SỬ DỤNG HỆ THỐNG KỸ THUẬT, 

TRANG BỊ VÀ THIẾT BỊ 

Mục 1 

VỊ TRÍ LÀM VIỆC 

3.1      Mô tả cơ sở hạ tầng 

Phòng AIP được bố trí 2 phòng làm việc: 

- Phòng Trưởng phòng AIP (Diện tích sử dụng 36m2); 

- Phòng AIP (Diện tích sử dụng 81m2) 

Diện tích tổng 2 phòng là 117m2 tại tầng 5 tòa nhà B -TCTQLBVN. Hai phòng 

làm việc được trang bị đầy đủ bàn ghế làm việc, tủ đựng tài liệu, phương tiện 

thông tin liên lạc, đồng hồ, có hệ thống báo cháy, môi trường điều hoà tổng đảm 

bảo cho thiết bị; hệ thống đèn chiếu sáng đáp ứng các tiêu chuẩn về cường độ 

sáng phù hợp trong điều kiện làm việc hành chính và tổ chức sản xuất; 

Phòng AIP có đặt các thiết bị đầu cuối AIP của Hệ thống AIM. Điện thoại: (84-

24) 38728521 hoặc (84-24) 38271513 số máy lẻ 8416, 8526 và 8653; email: 

aip_vatm@vatm.com, aip@vnaic.vn, aipvn.vnaic@gmail.com. 

3.2      Các vị trí làm việc và các vị trí liên quan khác 

- Có 4 vị trí đầu cuối AIP thuộc Hệ thống AIM (thiết bị đầu cuối hoạt động theo 

giấy phép của Cục HKVN); 

- Các vị trí làm việc khác có trang bị máy tính;  

- Máy điện thoại để liên lạc với các cơ quan, đơn vị liên quan. 

 

3.3  Bảng hiệu, ký hiệu liên quan, di chuyển trong khu vực làm việc 

Tại cổng ra vào cơ sở có bảng hiệu đề tên “Nhà B - Tổng công ty Quản lý bay 

Việt Nam”; Tại sảnh Nhà B trước cầu thang máy có biển chỉ dẫn các cơ quan đơn 

vị làm việc tại Tòa nhà B. Phòng AIP - Trung tâm TBTTHK ở phòng 530, tầng 

5 của toà nhà. Trước phòng làm việc của Phòng có bảng đề tên cơ sở bằng tiếng 

Việt: “Phòng AIP” và tiếng Anh: “AIP DIVISION”.  

3.4  Nội quy ra, vào cơ sở, vị trí làm việc, tiếp đón khách tham quan 

3.4.1   Nội quy ra vào cơ sở, vị trí làm việc 

Cán bộ, nhân viên của phòng khi ra/vào cơ sở, vị trí làm việc đeo thẻ kiểm soát 

an ninh do TCTQLBVN cấp hoặc thẻ ngành do Cục HKVN cấp. 

3.4.2  Tiếp đón khách đến liên hệ làm việc hoặc tham quan cơ sở 

- Khách đến liên hệ làm việc hoặc tham quan Phòng AIP - Trung tâm TBTTHK 

phải có kế hoạch thông báo trước cho Giám đốc Trung tâm và/hoặc Trưởng/Phó 

Trưởng phòng AIP và phải được sự cho phép của cơ quan, đơn vị có thẩm quyền;  

mailto:aip_vatm@vatm.com
mailto:aip@vnaic.vn
mailto:aipvn.vnaic@gmail.com
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- Khách đến tham quan phải có người hướng dẫn và tuân thủ theo người hướng 

dẫn của Phòng AIP cũng như các nội quy, quy định về an ninh, an toàn của 

TCTQLBVN.  

3.5  Quy định, hướng dẫn khác 

 Sẽ quy định bổ sung khi cần thiết. 

Mục 2 

KHAI THÁC SỬ DỤNG HỆ THỐNG KỸ THUẬT, TRANG BỊ VÀ THIẾT BỊ 

3.6     Danh mục các hệ thống kỹ thuật, trang bị, thiết bị sử dụng 

Stt Tên thiết bị Số lượng Chủng loại Tình trạng 

1.  
Đầu cuối AIP (thuộc hệ 

thống AIM) 
4  Hiện tại hoạt động tốt 

2.  
Điện thoại 

 

3 máy 4 số 

1 máy 8 số 
 Hiện tại hoạt động tốt 

3.  Máy tính văn phòng 13  Hiện tại hoạt động tốt 

4.  Máy in Laze đen trắng 4  Hiện tại hoạt động tốt 

5.  Máy in màu A3 1  Hiện tại hoạt động tốt 

6.  Máy photocopy 2  Hiện tại hoạt động tốt 

7.  Máy scanA3 1  Hiện tại hoạt động tốt 

3.7  Mô tả tóm tắt bố trí hệ thống kỹ thuật, thiết bị, đường truyền 

 Chi tiết bố trí sơ đồ hệ thống AIM xem tại Phụ lục 2 Tài liệu này. 

3.8  Tóm tắt tính năng khai thác, các sản phẩm của hệ thống kỹ thuật, trang bị, 

thiết bị 

Module chức năng eAIP.wiz@rd thuộc Hệ thống AIM được sử dụng để biên soạn 

các sản phẩm như: Tập AIP, Tập tu chỉnh AIP, Tập bổ sung AIP, Thông tri hàng 

không AIC. 

a)       Chức năng: 

1.  Quản lý tác vụ về biên soạn AIP 

2.  Khởi tạo eAIP 

3.  Khởi tạo Tu chỉnh AIP 

4.  Khởi tạo SUP 

5.  Khởi tạo AIC 

6.  Xuất bản AIP ở 2 định dạng PDF và HTML 

7.  Tích hợp bản đồ, sơ đồ HK 

8.  Quản lý ấn phẩm theo chu kỳ AIRAC 

9.  Lưu trữ tài liệu, dữ liệu tập trung 

mailto:eAIP.wiz@rd
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10.  Phân quyền xử lý các sản phẩm xuất bản 

11.  Quản lý phiên bản sản phẩm 

12.  Đăng tải sản phẩm lên Portal 

b) Cấu hình hoạt động 

- Cấu hình thiết bị: HP Prodesk 400 Microtower; Intel Core i5, 4.1GHz, 6 core, 

8M cache, 16GB RAM memory, 2 x 1TB 7200RPM, Intel Ethernet PCle x 1 Gb 

NIC, DVD-Writer ODD, USB port, HDMI, Display port, HP Z27k G3 4K USB-

C Display. 

- Hệ điều hành: Windows 10 Pro 64 OS, Edge Brower PDF viewing, Kaspersky 

Antivirus client 

3.9      Cách khai thác sử dụng hệ thống, trang bị, thiết bị và các ứng dụng 

Chi tiết cách khai thác sử dụng hệ thống AIM xem tại Phụ lục 3 Tài liệu này. 

3.10    Quy định về phối hợp xử lý khi có hỏng hóc, trục trặc kỹ thuật 

Khi có sự cố về thiết bị, vị trí khai thác phải báo cáo với nhân viên kỹ thuật - 

Phòng Bảo đảm kỹ thuật (số máy lẻ 8527, 8536) để tiến hành kiểm tra và khắc 

phục sự cố kịp thời. 
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Chương 4 

PHƯƠNG THỨC CUNG CẤP DỊCH VỤ 

4.1 Mô tả khu vực trách nhiệm 

Phòng AIP có trách nhiệm phối hợp với Cơ sở CSDLHK thu thập, kiểm tra, xử 

lý các tin tức/dữ liệu HK; biên soạn, in ấn và phát hành các sản phẩm TBTTHK 

của Việt Nam theo chỉ định của Cơ sở CSDLHK. Phối hợp đăng tải sản phẩm 

trên trang thông tin điện tử của Trung tâm TBTTHK, chuyển phát sản phẩm đến 

khách hàng trong nước và quốc tế. Trao đổi, bán, cấp phát sản phẩm TBTTHK 

đến các khách hàng trong nước và quốc tế. 

4.2      Đối tượng cung cấp dịch vụ 

Là những cá nhân, tổ chức, đơn vị, cơ sở, doanh nghiệp tham gia điều hành, khai 

thác hoạt động bay HKDD, bao gồm: 

- Các cơ sở cung cấp dịch vụ TBTTHK trong nước; 

- Các cơ sở điều hành bay thuộc TCTQLBVN, TCTHK Việt Nam và TCT Cảng 

HK Việt Nam; 

- Các cá nhân, doanh nghiệp, tổ chức trong và ngoài nước. 

4.3 Mô tả nội dung, phương thức cung cấp dịch vụ và các quy định 

4.3.1   Nội dung cung cấp dịch vụ 

Phòng AIP cung cấp các sản phẩm TBTTHK gồm Tập AIP, Tập tu chỉnh AIP, 

Tập bổ sung AIP, Thông tri HK tới các đầu mối liên quan trong và ngoài nước 

theo yêu cầu. 

4.3.2   Phương thức cung cấp dịch vụ 

- Chuyển bưu điện; 

- Chuyển trực tiếp; 

- Qua Wiz@rd Portal của Hệ thống AIM; 

- Qua Trang thông tin điện tử (có giới hạn và điều kiện truy cập). 

4.3.3   Các quy định về tin tức hàng không  

1) Phân loại tin tức hàng không 

a) Tin tức có tính chất tạm thời 

- Tin tức về việc dừng khai thác đường cất hạ cánh, đường lăn, sân đỗ; 

- Tin tức về việc dừng hoạt động để bảo dưỡng các phụ trợ dẫn đường, các phương 

tiện phục vụ điều hành bay; 

- Tin tức về các thay đổi quan trọng có ảnh hưởng đến việc khai thác bay; 

- Tin tức về hoạt động tại các khu vực cấm bay, khu vực hạn chế bay, khu vực 

nguy hiểm; 

- Những tin tức và các hoạt động khác có ảnh hưởng đến an toàn bay. 
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b)  Tin tức có tính chất lâu dài 

- Tin tức về việc đưa vào khai thác hoặc chấm dứt khai thác đường cất hạ cánh, 

đường lăn, sân đỗ và các phương tiện CNS; 

- Tin tức về số liệu đường cất hạ cánh của các sân bay; 

- Tin tức về kiểu loại, tần số và vị trí của các thiết bị phụ trợ dẫn đường trên đường 

bay; 

- Tin tức về ATS, COM, MET, SAR; 

- Các phương thức không lưu; 

- Những tin tức có tính chất lâu dài khác liên quan tới hoạt động bay. 

c)  Tin tức hành chính 

- Các văn bản pháp luật của Việt Nam có liên quan đến lĩnh vực HKDD; 

- Áp dụng hoặc miễn áp dụng các quy định của pháp luật Việt Nam trong lĩnh vực 

HKDD; 

- Các quy định bổ sung về cấp giấy phép hành nghề cho những người làm việc 

trong lĩnh vực khai thác - kỹ thuật HK; 

- Các quy định về huấn luyện, đào tạo cho những người làm việc trong lĩnh vực 

khai thác - kỹ thuật HK; 

- Tư vấn về việc sử dụng và bảo trì các dạng hệ thống kỹ thuật, trang bị, thiết bị 

đặc biệt; 

- Kế hoạch phát hành bản đồ, sơ đồ HK mới hoặc sửa đổi; 

- Trang bị các thiết bị vô tuyến điện; 

- Lựa chọn những hướng dẫn về duy trì đủ điều kiện bay; 

- Thay đổi loại NOTAM, phát hành tập AIP mới hoặc những thay đổi lớn về nội 

dung, phạm vi, hình thức của chúng; 

- Các tin tức khác có tính chất tương tự. 

2) Nguồn thu thập TTHK  

Để thực hiện biên soạn và phát hành sản phẩm TBTTHK được thu thập từ các 

nguồn sau đây: 

-  Cơ sở CSDLHK; 

- Cục HKVN; 

- TCTQLBVN; 

- TCT Cảng HK Việt Nam bao gồm các cảng HK trực thuộc; Cảng HKQT Vân 

Đồn; và  

- Các văn bản khác, nếu có. 

3) Phát hành tin tức 

a)   Phát hành tin tức thông thường 

Khi nhận được quyết định/văn bản đề nghị phát hành TTHK từ Cơ sở CSDLHK; 

Cục HKVN, TCTQLBVN, Phòng AIP đề xuất và phối hợp biên soạn, in ấn và 

phát hành ấn phẩm TBTTHK theo quy định. 
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b)  Phát hành tin tức theo chu kỳ AIRAC  

- Tin tức liên quan đến các trường hợp thiết lập, hủy bỏ hoặc những thay đổi quan 

trọng dưới đây phải được phát hành theo hệ thống AIRAC với ngày có hiệu lực 

chung theo quy định của ICAO với chu kỳ là 28 ngày. 

+ Giới hạn, phương thức khai thác FIR, khu vực kiểm soát và vùng trời kiểm soát; 

khu vực tư vấn không lưu; đường bay ATS; khu vực cấm bay, nguy hiểm, hạn 

chế bay và vùng nhận dạng phòng không (ADIZ); khu vực, đường bay hoặc các 

phần của vùng và đường bay có khả năng xảy ra bay chặn; 

+ Vị trí, tần số, tên gọi, các hiện tượng bất thường đã biết, chu kỳ bảo dưỡng của 

hệ thống, thiết bị dẫn đường vô tuyến và thông tin liên lạc, giám sát; 

+ Phương thức bay chờ, phương thức tiếp cận, SID, STAR, phương thức giảm tiếng 

ồn và các phương thức không lưu khác; 

+ Mực bay chuyển tiếp, độ cao chuyển tiếp, độ cao bay tối thiểu theo phân khu; 

+ Thiết bị khí tượng, các phương thức khai thác; 

+ Đường CHC và các đoạn dừng, đường lăn, sân đỗ; 

+ Phương án vận hành trên khu vực hoạt động tại sân bay (bao gồm cả phương án 

khai thác trong điều kiện tầm nhìn thấp); 

+ Đèn tiếp cận, đèn đường CHC; 

+ Tiêu chuẩn khai thác tối thiểu của sân bay cho cất cánh, hạ cánh.  

- Tin tức được phát hành theo hệ thống AIRAC không được thay đổi nội dung ít 

nhất là 28 ngày sau ngày có hiệu lực, ngoại trừ những trường hợp được thông báo 

mang tính chất tạm thời và không kéo dài hết chu kỳ; 

- Tin tức được cung cấp theo hệ thống AIRAC phải được công bố trước ngày có 

hiệu lực ít nhất là 42 ngày để đảm bảo tin tức được chuyển đến tay người sử dụng 

trước ngày có hiệu lực ít nhất là 28 ngày; 

- Khi không có tin tức để phát hành theo ngày chu kỳ AIRAC, một thông báo NIL 

sẽ được phát hành không muộn hơn 1 chu kỳ trước ngày có hiệu lực của chu kỳ 

AIRAC liên quan; 

- Không được sử dụng những ngày khác với ngày hiệu lực của hệ thống AIRAC 

để công bố những tin tức thay đổi quan trọng đã được lập kế hoạch trước, yêu 

cầu phải có bản đồ/sơ đồ minh họa và/hoặc để cập nhật vào các cơ sở dữ liệu dẫn 

đường; 

- Việc phát hành tin tức theo hệ thống AIRAC cũng nên được xem xét sử dụng để 

cung cấp thông tin tức liên quan đến việc thiết lập, hủy bỏ và những thay đổi 

quan trọng đã có kế hoạch như danh mục dưới đây:  

+ Vị trí, chiều cao và đèn chỉ báo của các chướng ngại vật dẫn đường; 

+ Giờ hoạt động sân bay, các phương tiện và dịch vụ;  

+ Dịch vụ hải quan, xuất nhập cảnh và dịch vụ chăm sóc sức khỏe;  

+ Các khu vực nguy hiểm, cấm và hạn chế bay tạm thời, các mối nguy cho hoạt 

động dẫn đường hàng không, diễn tập quân sự và các khu vực tập trung hoạt động 

của tàu bay; 

+ Các khu vực tạm thời, các đường bay hoặc các phần của đường bay có khả năng 

xảy ra bay chặn. 
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- Khi có những thay đổi quan trọng đã được lập kế hoạch thì phải sớm phát hành 

tin tức để có thể đến tay người nhận ít nhất là 56 ngày trước ngày có hiệu lực. 

Một số trường hợp thiết lập, thay đổi quan trọng được lập kế hoạch trước và 

những thay đổi lớn khác (nếu cần thiết) như danh mục được liệt kê dưới đây: 

+ Các sân bay mới phục vụ cho khai thác IFR quốc tế; 

+ Các RWY mới phục vụ cho khai thác IFR tại sân bay quốc tế; 

+ Thiết kế và cấu trúc mạng đường bay ATS; 

+ Thiết kế và cấu trúc của các phương thức bay trong khu vực tiếp cận (bao gồm 

cả thay đổi hướng phương thức bay do thay đổi độ lệch từ). 

- Tin tức liên quan đến những thay đổi đặc biệt quan trọng áp dụng trong các trường 

hợp nêu trên phải được gửi đến Cục HKVN và các cơ sở AIS liên quan ít nhất là 

70 ngày trước ngày có hiệu lực của chu kỳ AIRAC để xử lý, biên soạn và làm thủ 

tục phát hành. Tin tức hàng không không được gửi kịp thời đến cơ sở AIS theo 

thời hạn quy đinh như trên có thể bị từ chối công bố. 

4.3.4  Tiêu chuẩn về AIP Việt Nam, Tập tu chỉnh AIP, Tập bổ sung AIP, Thông tri 

hàng không (AIC) bản giấy 

4.3.4.1 Tập thông báo tin tức hàng không (AIP) 

Tiêu chuẩn về AIP Việt Nam tuân thủ theo quy định tại Phụ ước 15 của ICAO, 

Tài liệu 8126 ICAO và Phụ đính 2, Tài liệu PANS-AIM. 

● AIP phải bao gồm: 

a)   Tên của Nhà chức trách có thẩm quyền chịu trách nhiệm về các hệ thống, thiết bị, 

dịch vụ hoặc phương thức dẫn đường hàng không; 

b)   Các điều kiện trong đó các dịch vụ hoặc hệ thống, thiết bị được cung cấp để sử 

dụng trong nước và quốc tế; 

c)   Danh sách các khác biệt quan trọng giữa các quy định và thực tế khai thác của 

Việt Nam với tiêu chuẩn, khuyến cáo thực hành và các phương thức liên quan 

của ICAO, cho phép người sử dụng dễ dàng phân biệt giữa các yêu cầu của Việt 

Nam và các quy định của ICAO có liên quan; 

d)  Trong một số trường hợp đặc biệt, Quốc gia liên quan có thể xem xét lựa chọn 

phương án thực hiện thay thế cho tiêu chuẩn quốc tế, khuyến cáo thực hành và 

các phương thức của ICAO; 

đ)   Được in bằng hai thứ tiếng: Tiếng Việt và tiếng Anh;  

e)  Tập AIP Việt Nam - Phiên bản lần thứ 5 gồm 5 tập: 

- Tập 1: Phần Tổng quát (GEN) và phần Đường bay (ENR); 

- Tập 2: Phần Sân bay (AD) và tin tức/dữ liệu các sân bay Buôn Ma Thuột, Chu 

Lai, Cát Bi, Cà Mau, Cam Ranh, Côn Đảo; 

- Tập 3: Tin tức/dữ liệu các sân bay Cần Thơ, Điện Biên, Đồng Hới, Liên Khương, 

Đà Nẵng; 

- Tập 4: Tin tức/dữ liệu các sân bay Nội Bài, Phú Bài, Phù Cát, Pleiku, Phú Quốc, 

Rạch Giá; 

- Tập 5: Tin tức/dữ liệu các sân bay Tuy Hòa, Tân Sơn Nhất, Thọ Xuân, Vân Đồn, 

Vinh. 
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g)  Được xuất bản dưới dạng từng trang rời có song ngữ (tiếng Anh và tiếng Việt) 

trên cùng một mặt của mỗi trang; 

h)  Các tin tức trong tập AIP không được lặp lại hoặc trùng lặp với các sản phẩm 

TBTTHK khác; 

i)  Được cập nhật tin tức mới một cách thường xuyên bằng các Tập tu chỉnh AIP 

theo định kỳ phát hành một năm 5 lần vào ngày 28/2, 30/4, 30/6, 31/8 và 31/10 

và bằng các tu chỉnh theo chu kỳ AIRAC trong trường hợp cần thiết; 

Ghi chú:  

- AIP có mục đích chính là đáp ứng các yêu cầu quốc tế về việc trao đổi tin tức 

hàng không có tính chất ổn định lâu dài, cần thiết cho hoạt động bay; 

- AIP bao gồm những tin tức có giá trị lâu dài và những thay đổi tạm thời trong 

thời gian dài.  

● Nội dung của AIP Việt Nam 

a) AIP Việt Nam chứa đựng các tin tức phù hợp với Doc 8126 ICAO, Phụ đính 2, 

Tài liệu PANS-AIM để tạo thuận lợi cho việc sắp xếp tin tức theo tiêu đề cụ thể 

và lưu trữ, truy xuất tin tức bằng cách xử lý tự động; 

b) Trong trường hợp không có hệ thống, thiết bị hoặc không có tin tức để công bố 

đối với một trong các loại tin tức được nêu tại Phụ đính 2, Tài liệu PANS-AIM, 

cần cung cấp chỉ dẫn phù hợp (ví dụ: “Không có - NIL” hoặc “Không áp dụng - 

Not AVBL”); 

c) Khi bộ dữ liệu AIP được cung cấp, các nội dung sau đây của AIP có thể được để 

trống và phải tham chiếu đến bộ dữ liệu sẵn có được cung cấp: 

- GEN 2.5 Danh mục các phụ trợ dẫn đường vô tuyến 

- ENR 2.1 FIR, UIR, TMA và CTA 

- ENR 3.1 Các đường bay ATS tầng thấp 

- ENR 3.2 Các đường bay ATS tầng cao 

- ENR 3.3 Đường bay dẫn đường khu vực 

- ENR 3.4 Các đường bay trực thăng 

- ENR 3.5 Các đường bay khác 

- ENR 3.6 Khu chờ trên đường bay 

- ENR 4.1 Các đài phụ trợ dẫn đường vô tuyến trên đường bay 

- ENR 4.2 Các hệ thống dẫn đường đặc biệt 

- ENR 4.4 Tên điểm trọng yếu 

- ENR 4.5 Đèn hàng không phục vụ đường bay  

- ENR 5.1 Các khu vực cấm bay, hạn chế bay và nguy hiểm 

- ENR 5.2 Các không vực huấn luyện và diễn tập quân sự và ADIZ 

- ENR 5.3 Các hoạt động gây nguy hiểm khác 

- ENR 5.5 Hoạt động bay trình diễn và thể thao 

- **** AD 2.17 Vùng trời có kiểm soát không lưu 

- **** AD 2.19 Đài phụ trợ dẫn đường vô tuyến và hạ cánh 

- **** AD 3.16 Vùng trời có kiểm soát không lưu 
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- **** AD 3.18 Đài phụ trợ dẫn đường vô tuyến và hạ cánh 

d)   Khi bộ dữ liệu chướng ngại vật được cung cấp, các nội dung sau đây của AIP có 

thể được để trống và phải tham chiếu đến bộ dữ liệu sẵn có được cung cấp: 

ENR 5.4 Các ngại chướng vật trên đường bay - Khu vực 1 

**** AD 2.10 Chướng ngại vật sân bay 

**** AD 3.10 Chướng ngại vật sân bay trực thăng 

● Đặc điểm chung 

a) AIP phải nêu rõ quốc gia và cơ quan chịu trách nhiệm phát hành; 

b) Khi hai hoặc nhiều quốc gia cùng cung cấp một AIP, phải chỉ rõ tên của các quốc 

gia đó; 

c) AIP Việt Nam phải được phát hành bằng hai thứ tiếng: Tiếng Việt và Tiếng Anh 

và phải bao gồm mục lục.  

Ghi chú: Trong trường hợp AIP bao gồm nhiều nội dung hoặc để tạo điều kiện 

thuận lợi cho người sử dụng, AIP sẽ được xuất bản thành hai hoặc nhiều phần/tập 

khác nhau, mỗi phần/tập phải chỉ rõ những tin tức còn lại sẽ được trình bày tại 

các phần/tập khác. 

d) Tin tức trong AIP không được trùng lặp với nhau hoặc với các nguồn tin tức 

khác; 

đ) AIP Việt Nam gồm 03 phần: Tổng quát (GEN), đường bay (ENR) và sân bay 

(AD), bao gồm các mục và tiểu mục liên quan. Trong trường hợp AIP hoặc một 

tập của AIP được thiết kế để tạo thuận lợi cho hoạt động khai thác sử dụng trong 

chuyến bay, có thể điều chỉnh việc định dạng và sắp xếp nội dung phù hợp với 

mục lục tương ứng; 

e)  AIP được xuất bản dưới dạng từng trang rời, mỗi trang phải ghi rõ: Thời gian 

xuất bản hoặc thời gian có hiệu lực (nếu theo chu kỳ AIRAC) bao gồm ngày, 

tháng (bằng chữ), năm; tên quốc gia phát hành là Việt Nam; tên cơ quan phát 

hành là Cục Hàng không Việt Nam. 

  g) Các bản đồ, sơ đồ hoặc biểu đồ có thể được sử dụng để bổ sung hoặc thay thế cho 

các bảng hoặc phần chữ của AIP. 

Ghi chú: Bản đồ, sơ đồ hàng không được xuất bản phù hợp với Phụ ước 4 của 

ICAO về Sơ đồ hàng không có thể được sử dụng khi cần thiết để đáp ứng yêu 

cầu. Tài liệu hướng dẫn về thông số của bản đồ, sơ đồ và biểu đồ trong AIP được 

nêu tại Tài liệu hướng dẫn về AIS (Doc 8126) của ICAO 

h) Khi liệt kê các địa danh, thành phố hoặc thị trấn nơi có sân bay phải được viết 

bằng chữ in hoa, theo sau là một gạch chéo và tên của sân bay/sân bay trực thăng 

được viết bằng chữ in hoa nhỏ hơn hoặc chữ thường. Danh sách các sân bay phải 

được sắp xếp theo thứ tự bảng chữ cái. 

  i)  Việc đánh vần tên địa danh phải phù hợp với ngôn ngữ địa phương, được phiên 

âm khi cần thiết theo bảng chữ cái La Tinh cơ bản 

k) Quy định về việc biểu thị tọa độ địa lý của một vị trí: 

- Vĩ độ được đặt lên trước; 

- Bỏ qua các ký hiệu cho độ, phút, giây; 
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- Hai chữ số được sử dụng để biểu thị các giá trị nhỏ hơn 10 độ của vĩ độ; 

- Ba chữ số được sử dụng để biểu thị các giá trị nhỏ hơn 100 độ của kinh độ; 

- Các chữ cái N, S, E, W được sử dụng để chỉ các điểm chính trên la bàn tới các vĩ 

độ và kinh độ phù hợp. 

l)  Khi mô tả khoảng thời gian hoạt động, khả năng áp dụng hoặc khai thác, ngày và 

thời gian áp dụng phải được chỉ rõ. 

m) Các đơn vị đo lường được sử dụng trong AIP như các kích thước trên sân bay, 

cự ly, mức cao hoặc độ cao phải tuân thủ theo Phụ ước 5 của ICAO về Đơn vị đo 

lường trong khai thác bay dân dụng. 

n) Chỉ dẫn về bản đồ, sơ đồ và biểu đồ trong AIP phải tuân thủ: 

- Bản đồ cơ sở: Bản đồ cơ sở là bản đồ phác thảo khu vực được điều chỉnh từ thông 

tin hiện có với các chi tiết chung. Lưới, địa hình và các chi tiết khác được thể 

hiện đơn giản. Các khu vực hành chính nên được hiển thị và xác định bằng một 

màu; 

- Kích thước và tỷ lệ: Khổ giấy sử dụng không vượt quá 210 mm x 297 mm. Đối 

với khổ giấy rộng hơn phải gấp lại cho cùng cỡ giấy; 

- Tiêu đề và chú thích lề: Tiêu đề phải được hiển thị phía trên đường viền trên cùng 

và được thể hiện ngắn gọn, đơn giản; 

- Màu sắc: Số lượng màu phải được sử dụng ở mức tối thiểu. Nếu sử dụng nhiều 

hơn một màu thì màu sắc phải cung cấp độ tương phản đầy đủ; 

- Biểu tượng: Biểu tượng phải được thể hiện phù hợp ở những vị trí cần thiết. Các 

biểu tượng trên bản đồ, sơ đồ được quy định tại Phụ ước 4 của ICAO về Sơ đồ 

hàng không.  

4.3.4.2 Tập Tu chỉnh AIP Việt Nam  

 a)   Những tin tức của tập tu chỉnh AIP bao gồm những tin tức trong NOTAM, Tập 

bổ sung AIP có giá trị lâu dài, thông tri hàng không phù hợp, các tin tức có tính 

chất ổn định và lâu dài khác có liên quan. Có hai dạng tu chỉnh được thực hiện 

như sau: 

- Tu chỉnh thường xuyên (AIP AMDT) phải được phát hành vào ngày ấn định phù 

hợp với kế hoạch tu chỉnh hàng năm đã được công bố (một năm 5 lần vào 28/2, 

30/4, 30/6, 31/8, 31/10), bao gồm những thay đổi cố định, lâu dài được xác định 

bằng ngày xuất bản. Số lượng tu chỉnh thường xuyên hàng năm phải được công 

bố trong AIP, Phần 1 - Tổng quát (GEN); 

- Tu chỉnh theo chu kỳ AIRAC (AIRAC AIP AMDT) phải được phát hành phù 

hợp với chu kỳ AIRAC, bao gồm những thay đổi cố định lâu dài có nội dung khai 

thác quan trọng được xác định bằng ngày có hiệu lực.  

b)   Những tin tức mới hoặc thay đổi trong tập AIP phải được chú thích bằng hình 

thức đánh dấu để dễ nhận biết. 

- Một đường kẻ thẳng ở phần tiếng Anh, hoặc phần tiếng Việt hoặc cả hai phần: 

Có nội dung mới được thêm vào; 

- Lưu ý đối với tu chỉnh AIP:  

- Một đường kẻ thẳng và một mũi tên: Có nội dung được hủy bỏ và có nội dung 

mới được thêm vào;  
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- Một mũi tên: Có nội dung được hủy bỏ;  

- Hai mũi tên (thường xuất hiện ở trang danh mục sơ đồ): Có nội dung thay đổi 

liên quan đến (các) sơ đồ phía trên tên sơ đồ được đánh dấu hai mũi tên. 

c)  Các trang trong Tập tu chỉnh AIP được thay thế dưới dạng các trang rời. Mỗi trang 

phải ghi rõ ngày phát hành tin tức; nếu được phát hành theo chu kỳ AIRAC phải 

ghi rõ ngày có hiệu lực. 

d)   Khi thời gian hiệu lực không phải bắt đầu từ 0000 UTC thì phải xác định rõ thời 

gian này. 

đ)   Khi một Tập tu chỉnh AIP được phát hành, phải ghi rõ số của các Tập bổ sung 

AIP, điện văn NOTAM được đưa vào Tập tu chỉnh AIP đó. 

e)   Trang bìa của Tập tu chỉnh AIP phải nêu tóm tắt các nội dung được đưa vào Tập 

tu chỉnh. 

g)   Mỗi Tập tu chỉnh AIP phải bao gồm Bảng kiểm tra danh mục các trang bao gồm 

tất cả các trang còn hiệu lực, nêu rõ số trang, tên sơ đồ và ngày phát hành mỗi 

trang hoặc ngày có hiệu lực, nếu theo chu kỳ AIRAC. 

h)   Khi một tập tu chỉnh AIP không được phát hành theo chu kỳ quy định thì thông 

báo NIL về việc này sẽ được phổ biến thông qua NOTAM Checklist. 

i)    Các cơ quan, đơn vị có nhu cầu sửa đổi, bổ sung tin tức công bố trong AIP gửi 

đề nghị tu chỉnh AIP đến Phòng AIP ít nhất 56 ngày trước ngày có hiệu lực của 

tu chỉnh thường xuyên (được công bố trong AIC số 02 hàng năm). 

k)   Tin tức liên quan đến những thay đổi đặc biệt quan trọng đã được lập kế hoạch 

cần công bố ít nhất 56 ngày trước ngày có hiệu lực phải được gửi đến cơ sở AIS 

ít nhất 70 ngày trước ngày có hiệu lực của chu kỳ AIRAC để xử lý, biên soạn và 

phát hành. 

4.3.4.3 Tập bổ sung AIP Việt Nam 

a) Danh mục các Tập bổ sung AIP còn hiệu lực phải được phát hành mỗi tháng một 

lần thông qua Bản danh mục NOTAM còn hiệu lực và được gửi tới tất cả người 

nhận Tập bổ sung AIP. 

b) Quy định đối với Tập bổ sung AIP: 

- Tập bổ sung bao gồm các tin tức có tính chất tạm thời có hiệu lực từ 3 tháng trở 

lên, những tin tức ngắn hạn có nội dung dài và các biểu đồ, sơ đồ liên quan. 

- Tập bổ sung được phát hành bằng 2 hình thức như sau:  

+ Tập bổ sung thông thường bao gồm những tin tức cần phát hành bổ sung thông 

thường theo quy định; 

+ Tập bổ sung theo chu kỳ AIRAC bao gồm những thay đổi có tính chất khai thác 

quan trọng đối với các nội dung trong tập AIP. 

- Mỗi Tập bổ sung AIP được đánh số thứ tự kế tiếp nhau trên cơ sở lịch năm; 

- Mỗi Tập bổ sung AIP được phát hành bằng các trang đặc biệt để phân biệt với 

các trang AIP; 

- Khi Tập bổ sung AIP được phát hành thay thế NOTAM, phải nêu rõ số, loại 

NOTAM bị thay thế; 

- Mỗi trang của Tập bổ sung AIP thông thường phải có ngày phát hành; 

- Mỗi trang của Tập bổ sung AIP theo chu kỳ AIRAC phải có ngày phát hành và 
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ngày hiệu lực; 

- Tập bổ sung AIP của Việt Nam gồm có hai loại: Loại A để phát hành quốc tế và 

nội địa; loại C để phát hành nội địa. 

Ghi chú: Mẫu Tập bổ sung AIP Việt Nam thông thường và Tập bổ sung AIP Việt 

Nam theo chu kỳ AIRAC của Hệ thống AIM xem tại Phụ lục 4 Tài liệu này. 

4.3.4.4 Thông tri hàng không (AIC) 

a)   Một AIC sẽ được phát hành để thông báo: 

- Dự báo dài hạn về các thay đổi quan trọng liên quan đến các quy định pháp luật, 

quy trình hoặc hệ thống, thiết bị;  

- Tin tức mang tính chất giải thích đơn thuần hay tư vấn có khả năng ảnh hưởng 

đến an toàn bay; 

- Tin tức hoặc thông báo mang tính chất giải thích hay tư vấn về kỹ thuật, các vấn 

đề luật pháp hay về hành chính đơn thuần.  

b)   Hạn chế sử dụng AIC phát hành cho các tin tức phù hợp đưa vào AIP hoặc phát 

hành NOTAM. 

c)   Một bản tổng kết các AIC còn hiệu lực được phát hành một năm một lần và phát 

hành như một AIC thông thường. 

d)   Các trường hợp phát hành AIC: 

- Dự kiến những thay đổi quan trọng về phương thức, dịch vụ và hệ thống kỹ thuật, 

trang bị, thiết bị dẫn đường được cung cấp;  

- Dự kiến về việc thực hiện hệ thống dẫn đường mới; 

- Tin tức chính rút ra từ kết quả điều tra tai nạn, sự cố uy hiếp an toàn bay; 

- Tin tức quy định liên quan đến an ninh HK và bảo vệ hoạt động HKDD chống 

lại những hành vi can thiệp bất hợp pháp; 

- Tư vấn về vấn đề y tế có liên quan đặc biệt tới người lái và cảnh báo người lái 

tránh các nguy hiểm đối với sức khỏe; 

- Ảnh hưởng của một số hiện tượng thời tiết đặc biệt đối với hoạt động bay; 

- Tin tức về mối nguy hiểm mới ảnh hưởng đến kỹ thuật tàu bay; 

- Quy định liên quan đến việc vận chuyển hàng hóa hạn chế bằng đường HK; 

- Văn bản pháp luật của Việt Nam có liên quan đến lĩnh vực HKDD; 

- Giấy phép cho tổ bay; 

- Đào tạo, huấn luyện nhân viên hàng không; 

- Áp dụng hoặc miễn áp dụng các quy định của pháp luật Việt Nam trong lĩnh vực 

HKDD; 

- Tư vấn về việc sử dụng và bảo trì các dạng hệ thống kỹ thuật, trang bị, thiết bị 

đặc biệt; 

- Kế hoạch phát hành bản đồ, sơ đồ HK mới hoặc sửa đổi; 

- Trang bị các thiết bị thông tin liên lạc; 

- Tin tức giải thích liên quan đến vấn đề giảm tiếng ồn; 

- Lựa chọn những hướng dẫn về duy trì đủ điều kiện bay; 

- Thay đổi loại NOTAM, phát hành AIP mới hoặc những thay đổi lớn về nội dung, 
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phạm vi, hình thức của chúng;  

- Các tin tức khác có tính chất tương tự. 

đ)   AIC của Việt Nam gồm có hai loại: A và C: Loại A để phát hành quốc tế và nội 

địa; Loại C để phát hành nội địa.  

e)   Mỗi AIC sẽ được đánh số thứ tự liên tiếp nhau trên cơ sở lịch năm.  

Chú thích: Do tin tức trong AIC thường có hiệu lực trong thời gian dài và ít phải 

sửa đổi do vậy AIC có thể duy trì hiệu lực trong vài năm. Tuy nhiên, hàng năm 

cần xem xét, đánh giá và phát hành lại AIC đó. 

g) Danh mục AIC phát hành quốc tế phải được nêu trong Bản danh mục NOTAM 

còn hiệu lực. 

h) AIC thông báo những ngày quan trọng của chu kỳ AIRAC trong năm và có số 

A02/năm phát hành. Ví dụ: AIC A02/23. 

Ghi chú: Mẫu AIC Việt Nam (Hệ thống AIM) xem tại Phụ lục 4 Tài liệu này. 

4.3.5   Các quy định về sản phẩm TBTTHK điện tử 

- Khi được cung cấp, nội dung tin tức của các sản phẩm điện tử và cấu trúc của các 

chương, mục, tiểu mục phải tuân theo nội dung và cấu trúc của bản giấy và cho 

phép in được ra bản giấy; 

- AIP điện tử được cung cấp trực tuyến trên Internet qua trang thông tin điện tử 

của TTTBTTHK: www.vnaic.vn. 

4.4 Hiệp đồng/hợp đồng cung cấp dịch vụ 

Nhằm bảo đảm cung cấp dịch vụ TBTTHK với chất lượng tốt nhất tới người sử 

dụng, Trung tâm TBTTHK - TCTQLBVN đã tiến hành thảo luận và ký kết các 

Văn bản hiệp đồng và Văn bản phối hợp với các cơ quan, đơn vị liên quan đáp 

ứng yêu cầu hoạt động bay an toàn, điều hòa và hiệu quả.  

Ghi chú: Danh mục các văn bản hiệp đồng liên quan xem tại Phụ lục 5 Tài liệu này. 

4.5 Phương thức xử lý các trường hợp bất thường trong quá trình cung cấp dịch 

vụ 

- Khi có trường hợp bất thường xảy ra trong quá trình cung cấp dịch vụ, nhân viên 

TBTTHK của Phòng AIP có trách nhiệm báo cáo ngay cho Trưởng/Phó Trưởng 

phòng biết để xử lý; 

- Thực hiện báo cáo bằng văn bản (tường trình vụ việc) khi có yêu cầu. Khi báo 

cáo phải đính kèm với báo cáo các sản phẩm TBTTHK, các sơ đồ bản đồ hoặc 

các sản phẩm đã cung cấp cho đối tượng có liên quan đến vụ việc. 

Phương thức giải trợ Hệ thống AIM cho Phòng AIP: Khi hệ thống AIM ngừng 

cung cấp dịch vụ hoặc không hoạt động được: 

- Trưởng/Phó trưởng phòng AIP phân công nhóm nhân viên biên soạn sản phẩm 

sử dụng phần mềm Microsoft Word, phần mềm chỉnh sửa file HTML, PDF trên 

máy tính văn phòng để thực hiện biên soạn, chỉnh sửa sản phẩm. 

- Việc sử dụng máy tính văn phòng sẽ không ảnh hưởng gì đến người khai thác 

nên không cần hình thức thông báo nào cho người khai thác, sử dụng sản phẩm 

TBTTHK. 

http://www.vnaic.vn/
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Chương 5 

QUY TRÌNH TÁC NGHIỆP 

5.1 Các loại quy trình 

- Quy trình hoàn thiện sản phẩm; 

- Quy trình quản lý sản phẩm; 

- Quy trình xử lý sản phẩm TBTTHK nước ngoài (nếu nhận được); 

- Quy trình cập nhật tài liệu; 

- Quy trình xử lý thông tin phản hồi từ khách hàng. 

5.2 Quy trình hoàn thiện sản phẩm 

5.2.1  Nhận dữ liệu/tin tức  

Phòng AIP nhận dữ liệu/tin tức từ: 

+ Văn phòng điện tử (PO) do Văn phòng chuyển phát.  

+ Từ Cơ sở CSDLHK; 

+ Email: aip_vatm@vnaic.vn; aipvn.vnaic@gmail.com  

Cách thức xử lý:  

- Đối với dữ liệu/tin tức nhận qua email: Phòng AIP gửi Cơ sở CSDLHK để Cơ sở 

CSDLHK chủ trì, điều phối xử lý.  

- Đối với dữ liệu/tin tức nhận từ Cơ sở CSDLHK: Thực hiện theo sự điều phối của 

Cơ sở CSDLHK. 

5.2.2  Phối hợp kiểm tra dữ liệu/tin tức  

Phòng AIP phối hợp với Cơ sở CSDLHK kiểm tra, đánh giá sơ bộ DL/TT nhận 

được. Thời gian gửi lại ý kiến cho Cơ sở CSDLHK: Trong vòng 1 ngày làm việc 

kể từ khi nhận được DL/TT. 

+ Tính pháp lý của dữ DL/TT thô bao gồm: Các văn bản của Cục HKVN, Cảng 

HK Việt Nam, TCTQLBVN … ban hành, (có đóng dấu, chữ ký, e-mail của người 

có thẩm quyền của Cục HKVN);  

+ Tính kịp thời của DL và TT nhận được. 

+ DL và TT phù hợp để phát hành sản phẩm (AIC, AIP SUP, AIP AMDT). 

5.2.3  Thống nhất hình thức, thời gian, nội dung phát hành sản phẩm 

Phòng AIP phối hợp với Cơ sở CSDLHK để thống nhất hình thức, thời gian phát 

hành sản phẩm: 

1)  Dữ liệu/tin tức phù hợp để phát hành AIP SUP, AIC 

- Cán bộ phòng AIP phối hợp với Cơ sở CSDLHK để thống nhất ngày hiệu lực, 

ngày phát hành, và mốc thời gian biên soạn dự thảo, trình phê duyệt, hoàn thiện 

sản phẩm và phát hành. 

- Cán bộ Phòng AIP giao nhiệm vụ cho phụ trách bộ phận. 

mailto:aip_vatm@vnaic.vn
mailto:aipvn.vnaic@gmail.com
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- Phụ trách bộ phận giao nhân viên AIP phối hợp với Cơ sở CSDLHK rà soát AIP 

Việt Nam, SUP, AIC còn hiệu lực; 

- Nhân viên AIP, Cơ sở CSDLHK phối hợp với nhân viên NOF kiểm tra các 

NOTAM còn hiệu lực có liên quan và thống nhất các NOTAM được hủy bỏ khi 

ấn phẩm có hiệu lực (nếu có) qua tin nhắn Văn phòng điện tử hoặc email; 

2) Dữ liệu/tin tức phù hợp để phát hành AMDT 

Cán bộ Phòng AIP phối hợp với Cơ sở CSDLHK để thống nhất các mốc thời gian 

liên quan đến AIP AMDT: Trình danh mục nội dung dự kiến tu chỉnh; biên soạn 

tu chỉnh; trình dự thảo; ngày phát hành AIP AMDT. 

Sau khi thống nhất được thời gian trình danh mục nội dung dự kiến tu chỉnh, 

Phòng AIP thực hiện:  

a)  Thống kê danh mục các trang cần tu chỉnh 

- Căn cứ quy định phát hành AIP AMDT định kỳ và theo chu kỳ AIRAC hàng năm 

Phụ trách bộ phận giao cho 1 nhân viên thống kê danh mục tu chỉnh, 1 nhân viên 

kiểm tra; 

- Nhân viên thống kê danh mục tu chỉnh rà soát các sản phẩm, dữ liệu/tin tức dự 

kiến đưa vào AMDT giữa các kỳ tu chỉnh: 

+ Các ghi chú, văn bản, tài liệu nhận được giữa 2 kỳ tu chỉnh; 

+ Các Tập bổ sung AIP (AIP SUP) còn hiệu lực; 

+ Các Thông tri hàng không (AIC) còn hiệu lực; 

+ Các NOTAM PERM còn hiệu lực. 

- Nhân viên thống kê danh mục tu chỉnh đối chiếu với AIP Việt Nam hiện hành, 

đánh dấu và ghi chú các nội dung dự kiến tu chỉnh trên từng trang (lập file: Căn 

cứ AIP AMDT số…/năm…); 

- Sau khi ghi chú các nội dung dự kiến tu chỉnh, nhân viên thống kê danh mục tu 

chỉnh phải lập nội dung danh mục các trang cần tu chỉnh; 

- Nhân viên thống kê danh mục tu chỉnh sau khi lập xong nội dung danh mục các 

trang cần tu chỉnh chuyển cho nhân viên kiểm tra; 

- Nhân viên kiểm tra, tổng hợp rà soát sau đó chuyển cho 2 Phụ trách bộ phận kiểm 

tra (Nếu 2 Phụ trách bộ phận và nhân viên kiểm tra có chỉnh sửa hoặc bổ sung 

thì phải lập căn cứ đầy đủ, có chữ ký chuyển cho nhân viên thống kê danh mục 

tu chỉnh); 

- Nếu có căn cứ chỉnh sửa hoặc bổ sung sau các lần kiểm tra, 2 Phụ trách bộ phận 

yêu cầu nhân viên thống kê danh mục tu chỉnh phải chỉnh sửa, bổ sung và sau đó 

báo cáo và chuyển bản danh mục cho cán bộ phòng phụ trách kiểm tra. 

b) Thống nhất danh mục các trang dự kiến tu chỉnh và thời gian hoàn thiện danh 

mục tu chỉnh  

- Nhân viên AIP thống kê danh mục tu chỉnh gửi danh mục này 1 tháng trước ngày 

phát hành của tập tu chỉnh đó (qua VPĐT, e-mail) trước khi trình tới: 

+ Phòng BĐ-PTB: Ý kiến về sơ đồ dự kiến tu chỉnh, thời gian dự kiến hoàn thành 

sơ đồ tu chỉnh; 

+ Phòng NOTAM: Ý kiến về các NOTAM cần hủy bỏ. 
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+ Cơ sở CSDLHK: Thông báo và thống nhất ý kiến. 

- Các Phòng/Cơ sở CSDLHK có ý kiến trả lời trong thời hạn 3 ngày làm việc cho 

Phòng AIP kể từ ngày gửi danh mục. 

c)  Trình danh mục các trang dự kiến tu chỉnh 

- Phòng AIP trình Ban Không lưu - TCTQLBVN để TCTQLBVN trình Cục 

HKVN thông qua các nội dung và danh mục các trang dự kiến tu chỉnh. 

+ Nếu đồng ý với nội dung danh mục các trang dự kiến tu chỉnh → thông qua danh 

mục các trang và nội dung dự kiến tu chỉnh; 

+ Nếu yêu cầu điều chỉnh nội dung danh mục các trang dự kiến tu chỉnh: Phòng 

AIP phối hợp với Phòng BĐ-PTB, Phòng NOF, Cơ sở CSDLHK (nếu cần) điều 

chỉnh nội dung dự thảo danh mục theo ý kiến cấp có thẩm quyền. Sau khi hoàn 

thiện điều chỉnh dự thảo danh mục, Phòng AIP chuyển 1 bản danh mục các trang 

dự kiến tu chỉnh trình TCTQLBVN.  

5.2.4  Biên soạn sản phẩm, kiểm tra 

- Phòng AIP thực hiện biên soạn theo nhiệm vụ của Cơ sở CSDLHK đã chỉ định 

trên hệ thống AIM. 

- Nhân viên biên soạn Phòng AIP kiểm tra để đảm bảo DL và TT cung cấp đạt chất 

lượng theo yêu cầu Thông tư BĐHĐB, Annex 15, Doc 8126, Doc 10066: 

+ Nếu DL và TT không phù hợp với thực tế khai thác, nhưng không ảnh hưởng đến 

CSDL: Nhân viên biên soạn Phòng AIP trực tiếp liên lạc (bằng các hình thức tin 

nhắn, zalo, email, điện thoại bàn/mobile có ghi âm) với cơ quan/người khởi tạo 

dữ liệu để làm rõ cho tới khi DL và TT phù hợp thực tế khai thác. 

+ Nếu DL và TT không đáp ứng yêu cầu quy định nhưng có ảnh hưởng đến CSDL: 

Nhân viên biên soạn Phòng AIP thông báo cho Cơ sở CSDLHK để xử lý, xác 

minh làm rõ với cơ quan/người khởi tạo dữ liệu hoặc do dữ liệu đã cập nhật SDO 

không chính xác, không đầy đủ.  

+ Sau khi dữ liệu đã được cập nhật lại thì Cơ sở CSDLHK thông báo lại cho nhân 

viên biên soạn Phòng AIP qua điện thoại/email/VPĐT. 

Lưu ý: Phòng AIP chịu trách nhiệm làm rõ DL và TT liên quan đến phần chữ. 

- Sau khi nhân viên biên soạn và nhân viên kiểm tra, đối chiếu chuyển Phụ trách 

bộ phận kiểm tra và chuyển Cán bộ phòng (ghi rõ các lần kiểm tra, thời gian và 

ký tên). 

- Trong quá trình biên soạn và hoàn thiện sản phẩm, nhân viên biên soạn phải ghi 

thông tin đầy đủ vào bảng THEO DÕI BIÊN SOẠN SẢN PHẨM. 

- Trong quá trình biên soạn dự thảo sản phẩm: Nhân viên biên soạn Phòng AIP 

phối hợp với nhân viên biên soạn sơ đồ phòng BĐ-PTB/Cơ sở CSDLHK để kiểm 

tra, đối chiếu dự thảo sản phẩm:  

+ Nếu điều chỉnh nội dung trong sản phẩm có khác biệt so với DL/TT nhận được 

ban đầu theo ý kiến chỉ đạo của cơ quan có thẩm quyền: 

✓ Phụ trách Bộ phận phòng AIP thông báo cho Cơ sở CSDLHK (nếu ảnh hưởng 

đến CSDL) để xử lý. 
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✓ Cán bộ phòng AIP trực tiếp báo cáo lãnh đạo Trung tâm các nội dung sai lệch so 

với quyết định, công văn nhưng không ảnh hưởng đến CSDL. 

+ Nếu có sự khác biệt giữa phần chữ với phần sơ đồ, Phòng AIP trao đổi với Phòng 

BĐ-PTB để thống nhất điều chỉnh. Nếu không thống nhất được thì 2 phòng đồng 

thời báo cáo lãnh đạo Trung tâm và Phòng ATCL. Mọi thay đổi về DL/TT, Phòng 

AIP gửi các thông tin liên quan cho Cơ sở CSDLHK qua VPĐT/email (nếu cần). 

Lưu ý: Nhân viên Phòng BĐ-PTB chuyển dự thảo cho nhân viên biên soạn Phòng 

AIP theo hình thức sau: 

+ Bản điện tử: Có ghi rõ các phiên bản (Bản đầu tiên quy định là V1, những bản 

sửa đổi lần thứ 2, 3 trở đi quy định là V2, V3… và thêm ngày tháng để phân biệt) 

để tránh nhầm lẫn. Chuyển bản điện tử giữa 2 phòng theo thứ tự ưu tiên như sau:  

✓ Thư mục dùng chung (aip-map) của 2 phòng trên mạng nội bộ của Trung tâm; 

✓ Email: mapchart@vatm.vn; mappro@vnaic.vn; aip_vatm@vatm.vn; 

aip@vnaic.vn 

✓ USB. 

Sau khi phòng BĐ-PTB chuyển dự thảo sơ đồ vào ACM hệ thống AIM, nhân 

viên biên soạn Phòng AIP nhận sơ đồ (nguồn từ ACM) để hoàn thiện dự thảo sản 

phẩm. 

5.2.5  Trình dự thảo  

Sau khi cán bộ Phòng AIP thông qua nội dung dự thảo, nhân viên biên soạn 

Phòng AIP thực hiện như sau:   

Soạn thảo và trình công văn dự thảo sản phẩm lên cấp có thẩm quyền. Khi được 

cấp có thẩm quyền phê duyệt trình Ban Không lưu - TCTQLBVN thì nhân viên 

AIP gửi bản mềm dự thảo sản phẩm cho Ban Không lưu, Phòng An toàn - Chất 

lượng, Cơ sở CSDLHK, các Cảng HK có liên quan (nếu cần) để phối hợp thẩm 

định, kiểm tra và Cán bộ phòng AIP để báo cáo. 

5.2.6  Thẩm định 

- Khi được yêu cầu, Phó trưởng phòng phụ trách chuyên môn hoặc Phụ trách bộ 

phận báo cáo Ban Không lưu để phối hợp với cơ quan chuyên môn của Cục 

HKVN để làm rõ nội dung sản phẩm: 

+ Trong trường hợp đồng ý với nội dung dự thảo sản phẩm → thông qua nội dung 

để phát hành; 

+ Trong trường hợp TCTQLBVN hoặc cơ quan chuyên môn của Cục HKVN yêu 

cầu điều chỉnh nội dung sản phẩm (có bằng chứng để truy vết): Phụ trách bộ phận 

giao nhân viên biên soạn phối hợp với Phòng BĐ-PTB, Cơ sở CSDLHK điều 

chỉnh nội dung dự thảo sản phẩm theo ý kiến cấp có thẩm quyền. Sau khi hoàn 

thiện điều chỉnh dự thảo sản phẩm, Phòng AIP trình dự thảo lên cấp có thẩm 

quyền; 

+ Trong trường hợp TCTQLBVN hoặc cơ quan chuyên môn của Cục HKVN không 

thông qua phát hành sản phẩm: Phụ trách bộ phận giao nhân viên biên soạn thực 

hiện lưu các dự thảo sản phẩm không được thông qua phát hành và các căn cứ, lý 

do không đồng ý thông qua phát hành. 
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- Trong trường hợp TCTQLBVN chưa kịp trình dự thảo sản phẩm lên Cục HKVN 

bằng đường công văn do thời gian hiệu lực gấp: Nhân viên biên soạn gửi bản 

mềm dự thảo sản phẩm (qua email) tới cơ quan chuyên môn của Cục HKVN để 

thẩm định và báo cáo lý do tới Ban Không lưu và cán bộ Phòng AIP, Phòng An 

toàn - Chất lượng, Cơ sở CSDLHK. 

- Khi nhận được thông báo sản phẩm đã được thông qua bằng điện thoại thì Phụ 

trách bộ phận giao nhân viên biên soạn phải ghi rõ tên lãnh đạo có thẩm quyền 

ký và thông qua (thời gian cụ thể). 

Lưu ý: Trước khi được Cục HKVN thông qua phát hành, nhân viên biên soạn 

Phòng AIP phối hợp với nhân viên Phòng NOF kiểm tra lại số NOTAM đã đưa 

vào dự thảo. 

5.2.7  Đăng tải và thông báo cho khách hàng 

-  Nhân viên biên soạn xuất bản sản phẩm trên hệ thống AIM và đăng tải sản phẩm  

lên Trang thông tin điện tử của TTTBTTHK (Website: www.vnaic.vn) khi được 

Cục HKVN thông qua (nhân viên biên soạn ghi rõ thời gian được cấp có thẩm 

quyền thông qua vào Bảng theo dõi biên soạn sản phẩm). 

 Lưu ý:  

Đối với những sản phẩm Phòng AIP không trực tiếp đăng tải được do những hạn 

chế về hệ thống, Phụ trách bộ phận giao nhân viên phối hợp với Phòng BĐKT 

để đăng tải sản phẩm lên Trang thông tin điện tử của TTTBTTHK (Website: 

www.vnaic.vn) và ngay sau khi được Cục HKVN thông qua phát hành. Chi tiết 

đăng tải sản phẩm thực hiện theo Hướng dẫn đăng tải sản phẩm lên website. 

- Phụ trách bộ phận chịu trách nhiệm kiểm tra sản phẩm trước khi đăng tải cho 

khách hàng (là phiên bản cuối cùng được Cục HKVN ký ban hành sản phẩm); 

- Phụ trách bộ phận giao nhân viên gửi e-mail thông báo sản phẩm đã được đăng 

tải lên Trang thông tin điện tử của TTTBTTHK (Website: www.vnaic.vn) để 

khách hàng biết; 

Mẫu e-mail thông báo cho khách hàng: 

http://www.vnaic.vn/
http://www.vnaic.vn/
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5.2.8  Phối hợp thông báo phát hành thông báo NIL, Trigger NOTAM và các NOTAM 

khác (trong trường hợp cần thiết) 

Phòng AIP phối hợp với Cơ sở CSDLHK để thông báo cho Phòng NOTAM vể 

phát hành thông báo NIL, Trigger NOTAM và các NOTAM khác (trong trường 

hợp cần thiết). 

- Khi tin tức, dữ liệu thô nhận muộn, không đủ thời gian phát hành sản phẩm (AIP 

SUP, AIC): Phòng AIP và phòng NOF phối hợp để thống nhất nội dung cần phát 

hành NOTAM (qua tin nhắn văn phòng điện tử/email); 

- Khi một tập tu chỉnh AIP không được phát hành theo chu kỳ quy định, Phòng 

AIP phối hợp với Cơ sở CSDLHK thông báo cho phòng NOF ít nhất 28 này trước 

ngày hiệu lực của tập tu chỉnh đó qua tin nhắn văn phòng điện tử/email;  

5.2.9  In ấn sao chụp, kiểm tra bản in, chuyển phát sản phẩm 

1) In ấn, sao chụp sản phẩm 

a)    AIP SUP, AIC 
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Căn cứ công văn thông qua phát hành sản phẩm của Cục HKVN, Phụ trách bộ 

phận giao nhân viên thực hiện in ấn, sao chụp sản phẩm theo số lượng sản phẩm 

khách hàng đã đăng ký. 

b)    AIP AMDT 

- Căn cứ công văn thông qua phát hành AIP AMDT của Cục HKVN, Phụ trách bộ 

phận giao nhân viên làm công văn đề nghị in ấn AMDT (có số trang, số lượng 

bản in, yêu cầu chất liệu giấy v.v), gửi Văn phòng (Gửi kèm công văn thông qua 

phát hành AMDT của Cục HKVN); 

- Phụ trách bộ phận giao nhân viên phối hợp với Văn phòng, Phòng Kế hoạch, 

Phòng Tài chính thực hiện in ấn AIP AMDT theo quy định. 

2) Kiểm tra bản in 

Nhân viên phụ trách biên soạn sản phẩm chịu trách nhiệm kiểm tra bản in, sao 

chụp sản phẩm trước khi chuyển phát cho khách hàng (là phiên bản được Cục 

HKVN ký ban hành sản phẩm).  

3) Chuyển phát 

Phụ trách bộ phận giao nhân viên phối hợp với Văn phòng và Phòng Tài chính 

để thực hiện các thủ tục chuyển phát ấn phẩm trong nước, quốc tế theo Quy trình 

quản lý sản phẩm của Trung tâm. 

5.2.10 Kiểm soát sản phẩm sau phát hành 

1) Tiếp nhận, xử lý ý kiến phản hồi của khách hàng về sản phẩm sau khi phát hành 

Thực hiện theo Quy trình xử lý thông tin phản hồi từ khách hàng. 

2) Sửa lỗi cho nội dung sản phẩm đã phát hành 

Phòng AIP chủ trì, phối hợp với Cơ sở CSDLHK, phòng BĐ-PTB, NOF, để 

thống nhất phương án điều chỉnh, sửa đổi nội dung theo các phương án như sau: 

a. Phát hành 1 NOTAM thông báo kéo dài thời gian hiệu lực của sản phẩm; 

b. Phát hành 1 NOTAM sửa lỗi và có kế hoạch để đưa vào tu chỉnh/sản phẩm 

tiếp theo; Nếu kỳ Tu chỉnh AIP tiếp theo dài hơn 90 ngày, thì dữ liệu đã sửa nên 

được phát hành bằng một AIP SUP trong kỳ tiếp theo;  

c. Phát hành 1 AIP SUP mới thay thế để điều chỉnh nội dung cho AIP SUP đã 

phát hành.  

d. Phát hành AIP SUP khi trang chữ hoặc trang sơ đồ bị ảnh hưởng chưa có kế 

hoạch phát hành trong kỳ Tu chỉnh AIP tiếp theo; 

e. Sửa lỗi của dữ liệu đó ở trang text hoặc sơ đồ có liên quan trong kỳ tu chỉnh 

tiếp theo.  

3) Theo dõi hiệu lực của sản phẩm 

Đối với AIP SUP có thời gian dự kiến hết hiệu lực, 2 ngày trước thời hạn dự kiến 

Phụ trách bộ phận giao nhân viên biên soạn sản phẩm phối hợp với các bên liên 

quan (Cảng HK, sân bay; Phòng QLCHKSB, QLHĐB - Cục HKVN v.v) theo dõi 

hiệu lực của sản phẩm. Trường hợp đến thời gian dự kiến nêu trong AIP  SUP, nội 

dung ấn phẩm sẽ/chưa hoàn tất đúng theo kế hoạch, Cán bộ Phòng AIP báo cáo 

Cục HKVN, thông báo cho Cơ sở CSDLHK và phối hợp với Cán bộ Phòng NOF 
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thực hiện TBTTHK nếu cần. (Nội dung này sẽ được nhân viên phụ trách sản phẩm 

ghi rõ trong “Bảng theo dõi biên soạn sản phẩm” phần “Các hành động xử lý tiếp 

theo trong việc theo dõi hiệu lực của sản phẩm”). 

4)  Gỡ sản phẩm hết hiệu lực trên Trang thông tin điện tử của Trung tâm TBTTHK  

(Website: www.vnaic.vn) 

a)   Đối với AIP SUP, AIC 

Nếu AIP SUP, AIC mới thay thế/hủy bỏ AIP SUP, AIC phát hành trước đó, Phụ 

trách bộ phận giao nhân viên:  

- Đưa AIP SUP, AIC bị thay thế/hủy bỏ xuống phần vừa mới hết hiệu lực trên 

Trang thông tin điện tử của Trung tâm TBTTHK (Website: www.vnaic.vn)  vào 

ngày AIP SUP, AIC mới có hiệu lực; 

- Sau 15 ngày có hiệu lực của AIP SUP, AIC mới: Gỡ bỏ AIP SUP, AIC bị thay 

thế/hủy bỏ trong phần vừa mới hết hiệu lực trên Trang thông tin điện tử của Trung 

tâm TBTTHK (Website: www.vnaic.vn)  

b)   Đối với AIP AMDT 

Phụ trách bộ phận giao nhân viên:  

- Vào ngày phát hành của tu chỉnh: Đưa sản phẩm bị hủy bỏ bởi AMDT được liệt 

kê trong trang bìa (cover page) xuống phần vừa mới hết hiệu lực trên Trang thông 

tin điện tử của Trung tâm TBTTHK (Website: www.vnaic.vn). 

- 15 ngày sau ngày hiệu lực của AMDT: Gỡ bỏ các sản phẩm bị hủy bỏ bởi AMDT 

trong phần vừa mới hết hiệu lực trên Trang thông tin điện tử của Trung tâm 

TBTTHK (Website: www.vnaic.vn). 

5.2.11 Lưu trữ và cập nhật  

1)  Lưu trữ 

Phòng AIP thực hiện lưu trữ sản phẩm đã được phát hành dưới dạng bản giấy và 

bản điện tử. 

- Bản giấy: Hồ sơ lưu theo quy định; 

- Bản điện tử: Lưu trữ trên mạng nội bộ của phòng. Mỗi sản phẩm gồm các thư 

mục sau: 

+ Phần sơ đồ: Bản điện tử các sơ đồ phát hành theo sản phẩm do Phòng BĐ-PTB 

chuyển; 

+ Phần pdf: File sản phẩm - phiên bản đăng tải - dạng .pdf; 

+ Các công văn, văn bản, nếu có. 

Lưu ý: Để đảm bảo an toàn cho việc lưu trữ bản mềm, người chịu trách nhiệm 

lưu trữ nội dung bản mềm sản phẩm phải sao lưu thư mục trên mạng nội bộ trong 

máy tính cá nhân và/hoặc thiết bị lưu trữ ngoài phù hợp: 01_AIP & AIP AMDT; 

2_AIP SUP; 3_AIC. 

2) Cập nhật 

Phụ trách bộ phận giao nhân viên biên soạn: 

a) Đối với AIP SUP, AIC 

- Cập nhật Bảng theo dõi sản phẩm VN đã phát hành (file) trên mạng nội bộ phòng; 

http://www.vnaic.vn/
http://www.vnaic.vn/
http://www.vnaic.vn/
http://www.vnaic.vn/
http://www.vnaic.vn/
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- Cập nhật các văn bản liên quan đến các Cảng HK - sân bay, Phòng AIP sẽ lưu 

vào quy chế các sân bay nếu cần. 

b) Đối với AIP AMDT 

- Cập nhật Bảng theo dõi sản phẩm phát hành (file) trên mạng nội bộ phòng; 

- Cập nhật AIP lưu kho: Thực hiện cập nhật AIP lưu trong kho; 

- Cập nhật AIP gốc (để có thể theo dõi nội dung trong từng lần tu chỉnh liên quan 

đến từng trang trong AIP); 

- Cập nhật AIP dùng chung (để sử dụng chung mỗi khi cần tại vị trí 04 máy tính 

đầu cuối hệ thống AIM). 

5.3  Quy trình quản lý sản phẩm  

5.3.1 Quy trình thực hiện bán sản phẩm 

1) Rà soát, gửi thông báo và Order Form cho khách hàng 

Vào tháng 11 hàng năm, phòng AIP thực hiện: 

- Rà soát danh sách khách hàng mua sản phẩm hiện tại;  

- Gửi Order Form cho khách hàng để tiếp tục đăng ký mua sản phẩm cho năm tới. 

+  Đối với khách hàng nước ngoài: Gửi Order Form tiếng Anh; 

+  Đối với khách hàng Việt Nam: Gửi Order Form tiếng Việt. 

Ghi chú: Nhân viên Phòng AIP thực hiện gửi Order Form cho khách hàng đặt 

mua lần đầu khi có yêu cầu của khách hàng qua e-mail, điện thoại, fax, v.v. 

2) Tiếp nhận, xử lý thông tin khách hàng 

-   Khi nhận được Order Form của khách hàng, nhân viên Phòng AIP sẽ phản hồi 

(trong ngày) về việc đã nhận được yêu cầu của khách hàng. 

- Căn cứ Order Form khách hàng gửi, nhân viên Phòng AIP kiểm tra, rà soát các 

thông tin, liên lạc với khách hàng để tư vấn, làm rõ nếu cần; 

- Sau khi nhận được thông tin về việc mua sản phẩm của khách hàng, trong vòng 

01 ngày làm việc, nhân viên Phòng AIP chuyển 01 bản photo Order Form gửi 

cho Phòng Tài chính để phát hành Debit Note. 

3) Phát hành Debit Note/Báo giá 

- Căn cứ yêu cầu của khách hàng trong Order Form và quy định về giá bán sản 

phẩm trong GEN 3.1 - AIP Việt Nam, trong vòng 03 ngày làm việc, Phòng Tài 

chính phát hành Debit Note, 01 bản cho khách hàng và 01 bản cho Phòng AIP 

lưu. 

- Nhân viên Phòng AIP gửi Debit Note cho khách hàng qua e-mail hoặc bằng hình 

thức khách hàng yêu cầu: 

+   Đối với khách hàng nước ngoài: Gửi Debit Note tiếng Anh; 

+   Đối với khách hàng Việt Nam: Gửi Debit Note tiếng Việt. 

4) Phối hợp theo dõi tình trạng thanh toán 

- Phòng Tài chính thông báo cho Phòng AIP về tình trạng thanh toán theo Debit 
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Note của khách hàng; 

- Trong trường hợp Phòng AIP nhận được xác nhận đã thanh toán của khách hàng 

thì thông báo cho Phòng Tài chính để kiểm tra, đối chiếu với ngân hàng. 

5) Xuất hóa đơn cho khách hàng 

- Phòng Tài chính thực hiện xuất hóa đơn V.A.T cho khách hàng và chuyển cho 

Phòng AIP; 

- Phòng AIP chuyển bản gốc hóa đơn V.A.T cho khách hàng (qua đường bưu điện 

hoặc bằng hình thức khách hàng yêu cầu) và gửi bản scan qua email để thông 

báo.  

6) Tạo mới/tái kích hoạt tài khoản website 

- Phòng AIP: 

+ Tạo tài khoản mới và mở quyền truy cập (đối với khách hàng lần đầu sử dụng 

dịch vụ); hoặc 

+ Tái kích hoạt hoặc duy trì tài khoản (đối với khách hàng đăng ký sử dụng lại dịch 

vụ). 

- Sau đó, Phòng AIP thông báo tên đăng nhập/user name và mật khẩu/password 

cho khách hàng qua e-mail và yêu cầu khách hàng xác nhận. 

Lưu ý: Đến ngày 31/12 hàng năm, nếu Phòng AIP không nhận được Order Form 

tiếp tục đặt mua sản phẩm của khách hàng thì Phòng AIP đóng tài khoản đồng 

thời thông báo cho khách hàng qua email và tìm hiểu lý do khách hàng ngừng sử 

dụng dịch vụ.  

7) Phối hợp chuyển phát sản phẩm và/hoặc hóa đơn tài chính cho khách hàng 

- Phòng AIP phối hợp với Phòng Tài chính thực hiện thủ tục xuất kho sản phẩm, 

nếu cần; 

- Nhân viên Phòng AIP kiểm tra lại chất lượng, số lượng sản phẩm theo yêu cầu 

của khách hàng; cho vào phong bì/túi đựng hồ sơ có dán địa chỉ khách hàng (in 

đề can trên file được cập nhật); làm Phiếu yêu cầu gửi bưu phẩm, bưu kiện kèm 

theo danh sách khách hàng nhận bưu phẩm, bưu kiện, danh sách khách hàng gửi 

tay; 

- Sau khi nhận hóa đơn từ Phòng Tài chính, trong vòng 03 ngày làm việc, nhân 

viên Phòng AIP phối hợp với Văn phòng thực hiện thủ tục gửi sản phẩm và/hoặc 

hóa đơn tài chính cho khách hàng. 

8) Lưu trữ  

Nhân viên Phòng AIP thực hiện lưu trữ hồ sơ khách hàng dưới dạng bản cứng và 

bản mềm gồm: 

- Order Form; 

- Debit Note; 

- V.A.T Invoice; 

- Phiếu yêu cầu gửi sản phẩm kèm danh sách khách hàng nhận bưu phẩm, bưu kiện 

hoặc danh sách khách hàng gửi tay; 
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- E-mail xác nhận đã nhận tài khoản đăng nhập website (nếu có). 

Lưu ý: Để đảm bảo an toàn cho việc lưu trữ bản mềm, người chịu trách nhiệm 

lưu trữ nội dung bản mềm phải sao lưu folder 05_BAN VA TRAO DOI AN PHAM 

CUA VIET NAM trên mạng nội bộ trong máy tính cá nhânvà/hoặc thiết bị lưu trữ 

ngoài phù hợp. 

9) Cập nhật 

Nhân viên Phòng AIP thực hiện cập nhật trên mạng nội bộ phòng: 

- Bảng theo dõi khách hàng bán (quốc tế và quốc nội);  

- Bảng địa chỉ khách hàng bán (quốc tế và quốc nội) để dán nhãn cho sản phẩm khi 

gửi; 

- Phiếu yêu cầu gửi bưu phẩm, sản phẩm. 

5.3.2  Quy trình quản lý trao đổi quốc tế, cấp phát quốc nội sản phẩm 

1) Phân loại khách hàng trao đổi quốc tế, cấp phát quốc nội sản phẩm (thường niên, 

đột xuất) 

Nhân viên Phòng AIP thực hiện phân loại khách hàng trao đổi quốc tế, cấp phát 

quốc nội sản phẩm. 

2) Đề nghị phê duyệt khách hàng được cung cấp AIP và các sản phẩm TBTTHK:  

Đối với khách hàng thường niên: Trình lãnh đạo Trung tâm phê duyệt danh sách 

trao đổi quốc tế, cấp phát quốc nội AIP; 

- Đối với khách hàng đột xuất: Sau khi nhận yêu cầu từ khách hàng đột xuất qua 

điện thoại, e-mail, văn bản, phòng AIP trình lãnh đạo Trung tâm phê duyệt khách 

hàng được cung cấp AIP và các sản phẩm TBTTHK; 

- Sau khi được lãnh đạo Trung tâm phê duyệt, Phòng AIP thực hiện theo bước dưới 

đây:  

3) Tạo mới/tái kích hoạt tài khoản website: 

- Phòng AIP: 

+ Tạo tài khoản mới và mở quyền truy cập (đối với khách hàng đột xuất); hoặc 

+ Duy trì tài khoản (đối với khách hàng thường niên). 

- Sau đó, Phòng AIP thông báo tên đăng nhập/user name và mật khẩu/password 

cho khách hàng qua e-mail, điện thoại và yêu cầu khách hàng xác nhận. 

4) Phối hợp chuyển phát sản phẩm cho khách hàng 

- Phòng AIP phối hợp với Phòng Tài chính thực hiện thủ tục xuất kho sản phẩm, 

nếu cần; 

- Nhân viên Phòng AIP kiểm tra lại chất lượng, số lượng sản phẩm theo yêu cầu 

của khách hàng; cho vào phong bì/túi đựng hồ sơ có dán địa chỉ khách hàng (in 

đề can trên file được cập nhật, làm Phiếu yêu cầu gửi bưu phẩm, bưu kiện kèm 

theo danh sách khách hàng nhận bưu phẩm, bưu kiện hoặc danh sách khách hàng 

gửi tay; 

- Phòng AIP phối hợp với Văn phòng thực hiện thủ tục gửi sản phẩm cho khách hàng. 
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5) Lưu trữ  

Nhân viên Phòng AIP thực hiện lưu trữ hồ sơ khách hàng trao đổi quốc tế/cấp 

phát quốc nội sản phẩm dưới dạng bản cứng và bản mềm gồm: 

- Tờ trình về việc phê duyệt danh sách khách hàng trao đổi quốc tế/cấp phát quốc 

nội sản phẩm thường niên; 

- Tờ trình về việc phê duyệt danh sách khách hàng trao đổi quốc tế, cấp phát quốc 

nội sản phẩm đột xuất;  

- Phiếu yêu cầu gửi bưu phẩm, bưu kiện; 

- E-mail xác nhận đã nhận tài khoản đăng nhập website (nếu có). 

Lưu ý: Để đảm bảo an toàn cho việc lưu trữ bản mềm, người chịu trách nhiệm 

lưu trữ nội dung bản mềm phải sao lưu folder 5_BAN VA TRAO DOI AN 

PHAM CUA VIET NAM trên mạng nội bộ trong máy tính cá nhânvà/hoặc thiết 

bị lưu trữ ngoài phù hợp. 

6) Cập nhật 

Nhân viên Phòng AIP thực hiện cập nhật trên mạng nội bộ phòng: 

- Bảng theo dõi khách hàng trao đổi quốc tế; hoặc 

- Bảng theo dõi khách hàng cấp phát quốc nội;  

- Bảng địa chỉ khách hàng để dán nhãn cho sản phẩm khi gửi; 

- Phiếu yêu cầu gửi bưu phẩm, bưu kiện. 

5.4  Quy trình Xử lý ấn phẩm TBTTHK nước ngoài (nếu nhận được) 

- Nếu tin tức/dữ liệu có thể truy cập trong trang thông tin điện tử www.vnaic.vn -

→Hỗ trợ → AIP Quốc tế: Không cần lưu trữ. 

- Nếu tin tức/dữ liệu không thể truy cập trong trang thông tin điện tử www.vnaic.vn 

→ Hỗ trợ → AIP Quốc tế: Cần lưu trữ.  

- Nhận sản phẩm nước ngoài qua email: Nhân viên bộ phận Quản lý và Phát hành 

sản phẩm sẽ lưu 1 file mềm trên mạng nội bộ (06_SẢN PHẨM NHẬN TỪ 

QUỐC TẾ) hoặc in để lưu bản cứng. (Hiện tại, Việt Nam chỉ còn nhận sản phẩm 

nước ngoài từ Campuchia (gửi qua email)).  

- Nhân viên bộ phận Quản lý và Phát hành sản phẩm sẽ nghiên cứu nội dung ấn         

phẩm nhận được, chú ý các thay đổi quan trọng và tin tức mới được cập nhật, báo 

cáo (Trưởng phòng/TCT/CHK) những tin tức thay đổi nếu cần thiết.  

- Nhận sản phẩm nước ngoài dạng CD-ROM: Nhân viên Quản lý và Phát hành sản 

phẩm sẽ chuyển CD đó cho biên tập viên website để đăng tải trên trang thông tin 

điện tử www.vnaic.vn. 

- Phòng AIP phối hợp với Ban biên tập website AIS, Phòng Bảo đảm kỹ thuật tạo, 

cập nhật các địa chỉ, đường dẫn website truy cập sản phẩm TBTTHK quốc tế của 

các quốc gia đã có AIP điện tử tại mục “Sản phẩm quốc tế” (có giới hạn truy cập) 

trên thanh công cụ “Hỗ trợ” thuộc website của Trung tâm Thông báo tin tức hàng 

không (www.vnaic.vn). 

 

http://www.vnaic.vn/
http://www.vnaic.vn/
http://www.vnaic.vn/
http://www.vnaic.vn/


TÀI LIỆU HƯỚNG DẪN KHAI THÁC CƠ SỞ AIP  

Chương 5  

 

                                                                  V - 13                                             11/12/2023 

5.5     Quy trình Cập nhật tài liệu 

 Định kỳ hàng quý kiểm tra tình trạng cập nhật của các tài liệu hiện có. Khi có văn 

bản mới ban hành thay thế văn bản cũ thì phải thực hiện thay thế ngay.  

5.6     Quy trình xử lý thông tin phản hồi của khách hàng 

5.6.1  Tiếp nhận thông tin phản hồi từ khách hàng 

- Nhân viên Phòng AIP có trách nhiệm tiếp nhận các thông tin phản hồi của khách 

hàng thông qua:  

+ Quá trình làm việc trực tiếp với khách hàng; 

+ Điện thoại; Thư điện tử; Văn bản (thư từ, công văn, v.v). 

- Trường hợp khách hàng gửi thư phản hồi trực tiếp cho Phòng AIP thì nhân viên 

tiếp nhận thông tin phản hồi có trách nhiệm chuyển tiếp thư khách hàng cho 

Phòng An toàn - Chất lượng qua hộp thư sms.ais@vatm.vn hoặc thông báo nội 

dung phản hồi khách hàng qua tin nhắn trên VPĐT đến địa chỉ ais.atcl.nv. 

5.6.2   Phân tích thông tin phản hồi 

Nhân viên tiếp nhận phân tích thông tin phản hồi từ Phòng ATCL và báo cáo với 

cán bộ phòng để xác minh nội dung phản hồi và xác định cách thức xử lý. 

5.6.3   Xử lý thông tin phản hồi 

- Nhân viên nhận thông tin phản hồi trực tiếp đánh giá sự không phù hợp về dịch 

vụ/sản phẩm căn cứ vào nội dung thư: 

+ Nếu nội dung phản hồi không có sự không phù hợp nào xảy ra hoặc là do sự hiểu 

nhầm ở phía khách hàng, lỗi chính tả, lỗi đánh máy, thể thức v.v thì nhân viên 

phụ trách chuyên môn thực hiện các biện pháp xử lý kịp thời, đồng thời soạn dự 

thảo nội dung trả lời cho khách hàng, chuyển cán bộ phòng trong vòng 1 ngày 

làm việc kể từ khi nhận được thông tin; 

+ Nếu nội dung phản hồi là do sự không phù hợp ở sản phẩm, dịch vụ thì soạn thư 

trả lời khách hàng về việc đã nhận được thông tin; sau đó ngay lập tức phối hợp 

các cán bộ, các bộ phận chuyên môn liên quan để làm rõ nguyên nhân, đưa ra giải 

pháp xử lý, soạn dự thảo nội dung trả lời cho khách hàng, chuyển cán bộ phòng 

trong vòng 4 ngày làm việc kể từ khi nhận được thông tin. 

- Cán bộ phòng xem xét dự thảo thư: 

+ Nếu thuộc phạm vi giải quyết của phòng thì cán bộ phòng chuyển nội dung trả 

lời khách hàng (nội dung trả lời nêu rõ việc nhận trách nhiệm, biện pháp xử lý, 

biện pháp khắc phục) cho Phòng An toàn - Chất lượng qua hộp thư điện tử 

sms.ais@vatm.vn hoặc qua tin nhắn VPĐT ais.atcl.nv trong vòng 2 ngày làm việc 

kể từ khi nhận được thông tin, đồng thời chuyển bản trả lời cho Phòng QLHĐB 

theo địa chỉ and@caa.gov.vn. 

+ Nếu không thuộc phạm vi giải quyết của phòng thì cán bộ phòng có ý kiến đề 

xuất báo cáo cấp trên thông qua Phòng An toàn - Chất lượng bằng hai hình thức 

tương tự như trên trong vòng 5 ngày làm việc kể từ khi nhận được thông tin. 

-  Khi nhận thư khách hàng liên quan đến nội dung sản phẩm, phòng AIP gửi dự 

thảo thư trả lời khách hàng cho Phòng Quản lý hoạt động bay - Cục HKVN (qua 

email) để thẩm định trước khi gửi cho Phòng ATCL. 

mailto:sms.ais@vatm.vn
mailto:sms.ais@vatm.vn
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5.6.4   Theo dõi phản hồi khách hàng 

Nhân viên nhận thông tin phản hồi tiếp tục theo dõi phản hồi của khách hàng (nếu 

có) thông qua Phòng An toàn - Chất lượng và tiếp tục xử lý theo quy trình nêu 

tại các mục 5.7.1, 5.7.2, 5.7.3. 
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    HUẤN LUYỆN VÀ GIẤY PHÉP 

6.1 Loại hình huấn luyện  

● Huấn luyện năng định 

● Huấn luyện định kỳ 

● Huấn luyện phục hồi 

● Huấn luyện chuyển loại 

● Huấn luyện nâng cao 

- Bộ phận thực hiện: Huấn luyện viên TBTTHK AIP. 

- Cách thức tiến hành: Thực hiện theo Quy chế quản lý đào tạo - huấn luyện của 

TCT QLBVN và các quy định liên quan của TT TBTTHK. 

- Thời lượng huấn luyện: Quy định chi tiết tại Thông tư 10/2018/TT-BGTVT ngày 

14/3/2018 của Bộ Trưởng Bộ GTVT Quy định về nhân viên hàng không; Đào 

tạo, huấn luyện và sát hạnh nhân viên hàng không và Thông tư 35/2021/TT-

BGTVT ngày 17/12/2021 sửa đổi một số điều của Thông tư 10/2018/TT-

BGTVT; Quyết định của Cục HKVN ban hành Chương trình huấn luyện nhân 

viên TBTTHK. 

- Địa điểm huấn luyện: Phòng AIP. 

- Tài liệu huấn luyện: Tùy thuộc vào mục tiêu và đối tượng của khóa huấn luyện, 

danh mục các tài liệu sẽ được lựa chọn theo nội dung được quy định chi tiết tại 

Quyết định của Cục HKVN ban hành Chương trình huấn luyện nhân viên 

TBTTHK. 

- Nội dung của chương trình huấn luyện: Quy định chi tiết tại Quyết định của Cục 

HKVN ban hành Chương trình huấn luyện nhân viên TBTTHK. 

- Giáo trình huấn luyện: Sử dụng giáo trình huấn luyện được TCT QLBVN phê 

duyệt. 

6.1.1   Huấn luyện năng định 

- Mục tiêu: Nhằm trang bị cho học viên các kiến thức, kỹ năng chuyên môn cần 

thiết và thực tập tại vị trí nhân viên AIP. Sau khi hoàn thành khóa học, học viên 

đủ điều kiện tham gia kỳ sát hạch để cấp giấy phép, năng định nhân viên AIP. 

- Đối tượng: Học viên là nhân viên đã được cấp chứng chỉ chuyên môn phù hợp 

với vị trí năng định nhân viên AIP tại cơ sở đào tạo, huấn luyện nghiệp vụ nhân 

viên Hàng không của Việt Nam hoặc nước ngoài được CHKVN cấp phép hoặc 

công nhận. 

6.1.2   Huấn luyện định kỳ 

- Mục tiêu: Nhằm củng cố, nhắc lại cho nhân viên đang làm việc tại vị trí nhân 

viên AIP các kiến thức và kỹ năng đã được học; Cập nhật, bổ sung kiến thức mới 

về chuyên môn, nghiệp vụ, các quy chế, quy định có liên quan; Luyện tập thực 

hành để giúp cho nhân viên đang làm việc tại vị trí AIP duy trì đủ điều kiện làm 

việc ở vị trí công việc chuyên môn theo quy định. 
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- Đối tượng: Học viên là nhân viên đang làm việc ở vị nhân viên AIP có giấy phép 

và năng định còn hiệu lực. 

6.1.3   Huấn luyện phục hồi 

- Mục tiêu: Nhằm phục hồi, củng cố kiến thức và kỹ năng đã được học để đáp ứng 

công việc chuyên môn theo cho nhân viên AIP có thời gian nghỉ giãn cách quá 

thời gian quy định. 

-  Đối tượng: Học viên là nhân viên AIP đã có chứng chỉ chuyên môn, năng định 

và giấy phép nhân viên AIP nhưng không làm việc liên tục tại vị trí làm việc được 

chỉ định với thời gian từ 90 ngày trở lên. 

6.1.4   Huấn luyện chuyển loại 

- Mục tiêu: Nhằm trang bị kiến thức, kỹ năng chuyên môn dành cho nhân viên đã 

có năng định và đang làm việc tại vị trí chuyên môn NOTAM, AIS tại cảng HK, 

sân bay chuyển sang vị trí chuyên môn AIP nhưng chưa được huấn luyện phù 

hợp để có thể được phép tham gia kiểm tra để cấp năng định. 

- Đối tượng: Học viên là nhân viên đã có năng định vị trí chuyên môn NOTAM, 

AIS tại cảng HK, sân bay; xin dự kiểm tra cấp năng định ở vị trí chuyên môn 

AIP. 

6.1.5   Huấn luyện nâng cao 

- Mục tiêu: Chương trình nhằm trang bị kiến thức, kỹ năng chuyên môn dành cho 

nhân viên có trình độ, tay nghề, các chuyên gia AIS và cấp quản lý có thực hiện 

nhiệm vụ liên quan đến công tác chuyển đổi AIS sang AIM;  

- Đối tượng: Nhân viên đã có năng định vị trí chuyên môn, cán bộ quản lý.  

6.2     Lập và lưu trữ kế hoạch, báo cáo kết quả và hồ sơ huấn luyện 

6.2.1  Kế hoạch huấn luyện 

- Tên khóa học; 

- Mục đích của khoá huấn luyện; 

- Đối tượng huấn luyện; 

- Nội dung huấn luyện; 

- Chương trình, giáo trình, tài liệu giảng dạy; 

- Huấn luyện viên tham gia; 

- Địa điểm, thời gian huấn luyện; 

- Thời khóa biểu huấn luyện; 

- Yêu cầu chất lượng huấn luyện; 

- Dự trù kinh phí; 

- Tổ chức thực hiện: Đơn vị chủ trì, các phòng, đơn vị liên quan (Phòng Tổ chức 

cán bộ - Lao động, Tài chính, Văn phòng v.v.). 

6.2.2   Lập và lưu trữ kế hoạch, báo cáo kết quả và hồ sơ huấn luyện 

- Lập và lưu trữ kế hoạch: Thực hiện theo Hướng dẫn của Cục HKVN về lập và 
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lưu trữ hồ sơ huấn luyện nhân viên bảo đảm hoạt động bay; Quy chế Quản lý đào 

tạo - huấn luyện của TCT QLBVN và phân công trách nhiệm cụ thể của đơn vị. 

- Báo cáo kết quả huấn luyện: Khi kết thúc khóa huấn luyện, Phòng AIP nộp báo 

cáo gửi Phòng Tổ chức cán bộ - Lao động gồm: Bảng chấm công giờ dạy của 

giáo viên, huấn luyện viên; bảng điểm danh học viên; báo cáo kết quả tổ chức 

thực hiện khóa đào tạo, huấn luyện (nội dung, địa điểm, thời lượng, giáo viên, 

học viên v.v), bài kiểm tra; kết quả huấn luyện tại chỗ; danh sách nhận tiền thù 

lao giáo viên; Giấy đề nghị thanh toán/chuyển tiền (kèm bản kê chi tiết), hóa đơn, 

v.v. 

- Hồ sơ huấn luyện học viên được lưu trữ tại Phòng AIP, bao gồm: 

+ Sổ theo dõi huấn luyện nhân viên hàng không: Được lập theo dạng bản điện tử 

và in ra bản giấy; 

+ Bản sao chứng chỉ các khóa đào tạo, huấn luyện chuyên ngành liên quan; 

+ Các văn bản, giấy tờ theo quy định. 

6.3 Các lưu ý về việc đề nghị cấp, gia hạn giấy phép/năng định 

Thực hiện theo quy định của Thông tư quy định về quản lý và bảo đảm hoạt động 

bay; các quy định của Bộ Giao thông vận tải về nhân viên HK và cơ sở đào tạo, 

huấn luyện nghiệp vụ nhân viên HK; các quy định, hướng dẫn liên quan của Cục 

HKVN về giấy phép nhân viên, giấy phép khai thác cho cơ sở cung cấp dịch vụ 

bảo đảm hoạt động bay. 
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      LẬP BÁO CÁO, TỔNG HỢP SỐ LIỆU VÀ SẢN PHẨM 

7.1 Các loại báo cáo phải lập, bộ phận/nhân viên thực hiện, thời gian thực hiện 

- Báo cáo tổng hợp công tác chuyên môn trong tuần: Báo cáo Ban Giám đốc thông 

qua Văn phòng. 

+ Bộ phận/nhân viên thực hiện: nhân viên làm báo cáo thông qua cán bộ phòng 

trước khi gửi; 

+ Thời gian thực hiện: Trước 10h00, thứ Tư hàng tuần; 

+ Mốc thời gian báo cáo: Từ thứ Tư tuần trước đến hết thứ Ba của tuần báo cáo. 

- Báo cáo tổng hợp công tác chuyên môn tháng/quý/năm: Thời gian thực hiện và 

mốc thời gian báo cáo theo quy định của Trung tâm TBTTHK và TCT QLBVN; 

- Báo cáo An toàn - Chất lượng: Gửi Phòng An toàn - Chất lượng  

+ Bộ phận/nhân viên thực hiện: Nhân viên phụ trách Cảng HK, sân bay làm báo 

cáo trên phần mềm web:http://qms.vnaic.vn; Nhân viên phụ trách báo cáo ATCL 

làm báo cáo thông qua cán bộ phòng trước khi gửi;  

+ Thời gian thực hiện: Thứ Tư hàng tuần hoặc ngay khi có nội dung cần báo cáo 

theo quy định. 

7.2  Các loại số liệu tổng hợp, bộ phận/nhân viên thực hiện, thời gian thực hiện 

- Các loại số liệu sau được Phòng AIP tổng hợp báo cáo: 

+ Các sản phẩm (AIP AMDT, AIP SUP, AIC) (số trang dự kiến) được phát hành; 

+ AIP quốc tế hiện có; 

+ Số lượng AIP của Việt Nam trao đổi, bán, cấp phát trong năm. 

- Bộ phận/nhân viên thực hiện: Nhân viên phụ trách báo cáo;  

- Thời gian thực hiện: Hàng tuần/tháng/quý. 

7.3  Các loại sản phẩm lưu trữ 

Các căn cứ phát hành các sản phẩm (AIP, AIP AMDT, AIP SUP, AIC). 
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DANH MỤC CÁC PHỤ LỤC 

 

Phụ lục 1: Sơ đồ tổ chức khối của cơ sở 

Phụ lục 2: Sơ đồ bố trí hệ thống kỹ thuật, thiết bị, đường truyền 

Phụ lục 3: Cách khai thác sử dụng hệ thống, trang bị, thiết bị và các ứng dụng 

Phụ lục 4: Mẫu các sản phẩm TBTTHK của Hệ thống AIM 

Phụ lục 5: Danh mục các văn bản hiệp đồng liên quan 
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Phụ lục 1:  

Sơ đồ tổ chức khối của cơ sở 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Tổng công ty Quản lý bay Việt Nam  

Trung tâm Thông báo tin tức hàng không  

Phòng AIP 

Bộ phận 

Ấn phẩm 

 

Bộ phận 

Dữ liệu 
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Phụ lục 2: 

Sơ đồ bố trí hệ thống kỹ thuật, thiết bị, đường truyền 

 

1. Sơ đồ mặt bằng tổng thể của cơ sở 

 
Sơ đồ phòng Trưởng phòng AIP 

 

Sơ đồ Phòng AIP 
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2. Sơ đồ hệ thống AIM 

 

AIM
AIMAIM

AIP

Máy in hệ 

thống

Switch 24 port

Switch 24 port

AIM
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Phụ lục 3:  

Cách khai thác sử dụng hệ thống, trang bị, thiết bị và các ứng dụng 

I. Quản lý tác vụ về biên soạn AIP 

Tất cả các thay đổi được thực hiện trong eAIP.wiz@rd được thực hiện trên cơ sở 

ít nhất 1 nhiệm vụ được chọn. 

Muốn thay đổi dữ liệu trong văn bản tài liệu đang mở để chỉnh sửa và chưa chọn 

thao tác nào, thì hệ thống eAIP sẽ hiển thị cửa sổ cảnh báo: 

 

a) Xác nhận lựa chọn nhiệm vụ bằng cách nhấn YES; hoặc 

b) Lựa chọn eAIP > Tasks > Select.  

c) Sau khi kích hoạt lựa chọn nhiệm vụ, cửa sổ hộp thoại LookUp từ AIP sẽ mở 

ra cho phép chọn nhiệm vụ.  

d) Chọn bằng cách nhấp chuột trái vào hàng có số nhiệm vụ mong muốn > 

Confirm (Lặp lại các bước này nếu bạn chọn nhiều nhiệm vụ). 

Ghi chú: Các nhiệm vụ được sắp xếp theo số nhận dạng duy nhất của chúng như 

loại, số, ngày hiệu lực, ngày phát hành. 

 

e) Chọn Select > Show để xem chi tiết của các nhiệm vụ đã chọn. 

II. Khởi tạo tu chỉnh AIP 

II.1 Mở tập tu chỉnh AIP 

a) Khởi tạo phiên bản sản phẩm mới 

 Chọn eAIP > File > New Version > Publication. Cửa sổ New Version sẽ mở. 
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Ghi chú: Các thuộc tính của sản phẩm như: Publication type; Number; Effective 

Date; Publication Date; Cut-of date. 

b) Lựa chọn loại sản phẩm muốn khởi tạo, lựa chọn chu kỳ cho sản phẩm được tạo 

Với AIP AMDT tạo New Version từ AMDT gần nhất được xuất bản, chọn Closed 

versions only.  

Ghi chú: Khi Closed versions only được chọn phiên bản cuối cùng đã đóng còn 

hiệu lực mới được hiển thị.  

 

c) Tạo sản phẩm mới bằng cách ấn nút Create.   

d) Trong quá trình tạo sản phẩm mới, cung cấp tính năng tự động tạo các phiên bản 

mới của một số tiểu mục như sau: 

- Với các tiểu mục dữ liệu tĩnh đã được thay đổi (dựa trên các thay đổi trong eSDO, 

eMAP) bao gồm dữ liệu tĩnh/ sơ đồ đã được thay đổi thành ngày có hiệu lực của 

sản phẩm mới vừa được tạo. 

- Dựa trên các tham chiếu AIP được thực hiện cho các tiểu mục (được tham chiếu 

bởi bất kỳ task nào trong TMS) và được liên kết với chu kỳ sản phẩm vừa được 

tạo. 

 

- Các tệp đã được tạo - đây là những tài liệu thường xuyên được cập nhật và phát 

hành với một phiên bản mới (ví dụ: TOC).  
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- Chỉ tạo Report - Không có phương án nào ở trên được thực sự thực hiện, chỉ một 

bản nháp được tạo để cho biết điều gì sẽ xảy ra. 

e) Sau khi đã chọn nội dung mà bạn muốn tạo trong sản phẩm mới: Hệ thống sẽ 

khởi tạo một thông báo về việc tạo các phiên bản mới của các file được chọn 

thành một tài liệu mới. 

Ghi chú: Thông báo này được tạo ra chỉ nhằm mục đích cung cấp thông tin và 

có thể lưu tệp “Untitled1.fm” này hoặc không, tùy theo mong muốn. 
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II.2 Hoàn thiện tập tu chỉnh AIP 

Bước 1: Hoàn thiện sản phẩm 

1. Bắt đầu quy trình hoàn thiện bằng cách sử dụng tùy chọn eAIP> Finalization> 

Finalize Working Book.  

 

2. Cửa sổ hộp thoại Cây AIP mở ra: Trong cây, chỉ hiển thị những tiểu mục phiên 

bản mới trong sản phẩm đã hoàn thiện. Các trang có một số thay đổi được hiển 

thị bằng hộp kiểm tra được gắn cờ vàng. 
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3. Có thể ghi đè các trang đã thay đổi theo cách thủ công. Nếu cả hai trang (hai 

mặt, ghép mặt) bị thay đổi (được đánh dấu màu vàng), bạn có thể xóa (ghi đè thủ 

công) cờ đã thay đổi cho một trong số chúng. 

Bước 2: Tạo tài liệu 

Một số tiểu mục được tạo tự động. Các tiểu mục là Danh sách các trang sửa tay 

và Mục lục 

1. Chọn eAIP> Finalization> Generate> TOCs.  

2. Chọn TOC bạn muốn tạo và xác nhận hoạt động. 

3. TOC đã chọn được tạo. 

4. Bắt đầu tạo Mục lục bằng cách chọn eAIP> Finalization> Generate> Hand 

Corrections. 

5. Danh sách các trang sửa tay được tạo. 

Lưu ý: Sau bước này, bạn có cơ hội sửa đổi thủ công tạo các tiểu mục nếu cần 

thiết.  
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Bước 3: Hoàn thiện tài liệu đã tạo 

1. Chọn eAIP> Finalization> Finalize Generated Documents. 

 

2. Cửa sổ hộp thoại AIP Tree mở ra: Trong cây, chỉ hiển thị những tiểu mục phiên 

bản mới trong sản phẩm đã hoàn thiện. Các trang có một số thay đổi được hiển 

thị bằng hộp kiểm tra được gắn cờ vàng. 
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Bước 4: Tạo bảng kiểm tra danh mục các trang 

1. Chọn eAIP> Finalization> Generated> Checklist. 

 

2. Danh mục các trang được tạo. 
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Bước 5: Hoàn thiện bảng kiểm tra danh mục các trang 

1. Chọn eAIP > Finalization > Finalize Checklist.  

 

2. Danh mục các trang được hoàn thiện.  

3. Hệ thống hỏi bạn có muốn đưa danh mục các trang vào bản sửa đổi hay không. 

Tùy chọn này ảnh hưởng đến chức năng Tạo bản in AIP. 

 

Bước 6: Tạo trang bìa 

1. Chọn eAIP> Finalization> Generate> Cover Page. 
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2. Trang bìa được tạo.  

Lưu ý: Sau bước này, bạn có cơ hội sửa đổi trang bìa theo cách thủ công nếu cần. 

Bước 7: Tạo tệp in 

Mục tiêu của bước này là tạo một tệp PDF cho mục đích phát hành của người dùng. 

1. Chọn eAIP> Finalization> Create AMDT AIP.  

 

2. Hệ thống hỏi nếu bạn muốn đưa trang bìa vào tệp đã tạo.  

3. Tệp in được tạo. 

Bước 8: Đóng sản phẩm  

1. Chọn eAIP> Finalization> Lock Book.  
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2. Sản phẩm được đóng 

 

Lưu ý: Các ấn bản mới của sản phẩm chỉ nên được tạo từ các sản phẩm đã được 

đóng. 

II.3. Khởi tạo SUP 

1. Mở một tập bổ sung 

a) Chọn mục eAIP> SUP> Open hoặc eAIP> SUP> Update header 
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b) Cửa sổ hộp thoại Open supplement được hiển thị:  

Người biên tập kiểm tra sản phẩm cần tạo qua các thuộc tính như: Supplement 

type, Cycle Number and Valid From / To: Supplement validity from / to... 

c) Trong bảng này hệ thống hiển thị các phiên bản  và những lần thực hiện tập bổ 

sung (nếu ô Only last version không được chọn) được sắp xếp có trình tự bởi 

Valid from and Version (giảm dần). Chọn một tập bổ sung từ bảng và xác nhận 

lựa chọn bằng cách nhấp vào nút OK. 

d) Hệ thống mở phiên bản của tập bổ sung bạn đã chọn. 

Ghi chú: Hệ thống chỉ cho phép bất kỳ hành động biên soạn nào vào tập bổ sung 

khi tập bổ sung đó ở trạng thái là "In Progress" và không bị khóa bởi người sử 

dụng khác. Các tập bổ sung ở bất kỳ trạng thái nào khác sẽ được mở ở chế độ 

chỉ - đọc và hệ thống sẽ thông báo đến người sử dụng bằng một thông báo cảnh 

báo tương ứng. 

2. Hoàn thiện Tập bổ sung 

Để hoàn thiện tập bổ sung thực hiện như sau:  

a) Chọn mục eAIP> SUP> Finalize. 
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b) Cửa sổ hộp thoại Finalize supplement sẽ được mở ra. Trong hộp thoại đó có thể 

chọn: Supplement type, Cycle Number. 

c) Chọn tập bổ sung bằng cách nhấp vào OK. Hệ thống sẽ thay đổi trạng thái của 

tập bổ sung đã được chọn để hoàn thiện và sẽ hiển thị nó ở chế độ chỉ - đọc. 

Ghi chú: Hệ thống hiển thị tất cả các tập bổ sung đang ở trạng thái "In 

Progress". Khi người sử dụng chọn tập bổ sung mà đang được người sử dụng 

khác kiểm tra, hệ thống sẽ đưa ra thông báo sau: 

 

3. Không hoàn thiện Tập bổ sung 

Có thể không hoàn thiện Tập bổ sung và mở nó ra để tiếp tục chỉnh sửa 

a) Chọn mục eAIP> SUP> Unfinalize. 
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b) Cửa sổ hộp thoại Unfinalize supplement sẽ được mở ra. Trong cửa sổ này có 

thể chọn Supplement type, Cycle Number.  

c) Chọn tập bổ sung này bằng cách nhấp vào nút OK. Hệ thống sẽ thay đổi trạng 

thái của tập bổ sung đã được chọn thành “In Progress” và sẽ hiển thị nó ở chế 

độ chỉnh sửa.  

d) Hệ thống hiển thị chỉ những tập bổ sung đó ở trạng thái "Finalized ". 

II.4. Khởi tạo AIC 

1. Mở một tập bổ sung thực hiện các bước sau: 

a) Chọn mục eAIP> AIC> Open AIC 

 

b)  Cửa sổ hộp thoại Open AIC được hiển thị:  

Người biên tập kiểm tra sản phẩm cần tạo qua các thuộc tính như: AIC type, 

Cycle Number, Publication date … 

c) Trong bảng này hệ thống hiển thị các phiên bản và những lần thực hiện AIC (nếu 

ô Only last version không được chọn) được sắp xếp có trình tự giảm dần (phiên 

bản được tạo mới nhất ở trên cùng). Chọn một AIC từ bảng và xác nhận lựa chọn 

bằng cách nhấp vào nút OK. 
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d) Hệ thống mở phiên bản AIC bạn đã chọn. 

Ghi chú:  

- Khi bạn không chọn một phiên bản nào thì hệ thống sẽ mở phiên bản đã được 

tạo mới nhất của AIC đã chọn. 

- Hệ thống chỉ cho phép biên soạn AIC khi AIC đó ở trạng thái là "In Progress" 

và không bị khóa bởi người sử dụng khác. Các AIC ở bất kỳ trạng thái nào khác 

sẽ được mở ở chế độ chỉ - đọc và hệ thống sẽ thông báo đến người sử dụng bằng 

một thông báo cảnh báo tương ứng. 

2. Hoàn thiện AIC 

Để hoàn thiện AIC thực hiện như sau:  

a) Chọn mục eAIP> AIC> Finalize. 

 

b) Cửa sổ hộp thoại Finalize AIC sẽ được mở ra. Trong hộp thoại đó có thể chọn: 

AIC type, Cycle Number. 

c) Chọn tập bổ sung bằng cách nhấp vào OK. Hệ thống sẽ thay đổi trạng thái của 

tập bổ sung đã được chọn để hoàn thiện và sẽ hiển thị nó ở chế độ chỉ - đọc. 

Ghi chú: Hệ thống hiển thị tất cả các tập bổ sung đang ở trạng thái "In 

Progress". Khi người sử dụng chọn tập bổ sung mà đang được người sử dụng 

khác kiểm tra, hệ thống sẽ đưa ra thông báo sau: 

 

3. Không hoàn thiện AIC 

Có thể không hoàn thiện AIC và mở nó ra để tiếp tục chỉnh sửa 

a) Chọn mục eAIP> AIC> Unfinalize AIC. 
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b) Cửa sổ hộp thoại Unfinalize AIC sẽ được mở ra. Trong cửa sổ này có thể chọn 

AIC type, Cycle Number.  

c) Chọn AIC này bằng cách nhấp vào nút OK. Hệ thống sẽ thay đổi trạng thái của 

tập bổ sung đã được chọn thành “In Progress” và sẽ hiển thị nó ở chế độ chỉnh 

sửa.  

d) Hệ thống hiển thị chỉ những AIC ở trạng thái "Finalized ". 

II.5. Xuất bản AIP ở 2 định dạng PDF và HTML 

II.5.1. Xuất sản phẩm ở định dạng PDF 

a) Chọn eAIP > File > Export > Publication in PDF 

b) Xuất AMDT: eAIP > File > Export > AMDT in PDF 

c) Xuất AIP SUP: eAIP > AIC > Export AIC as PDF 

d) Xuất AIC: eAIP > AIC > Export AIC as PDF 

II.5.2. Xuất sản phẩm ở định dạng HTML: 

1. Định dạng thủ công: 

 Chọn eAIP > File > Export > Publication in eAIP XML/HTML 
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2. Định dạng HTML tự động (chỉ áp dụng nếu hệ thống được cấu hình để dùng 

html): 

Chọn eAip > File > Export > HTML > Generate XML/HTML from 

Publication 

a) Hệ thống xuất hiện hộp thoại cơ bản: 

 

b) Nhấp vào Show Advanced Options sẽ xuất hiện hộp thoại nâng cao: 
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3. Xuất gói eAIP HTML: Chức năng này được dùng để tạo một gói HTML sẵn sàng 

để phát hành gồm nhiều nội dung. 

 Từ menu eAip > File > Export > HTML > eAIP HTML Pack. 

a) Hệ thống xuất hiện hộp thoại cơ bản: 

 

b) Nhấp vào Show Advanced sẽ xuất hiện hộp thoại nâng cao: 
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II.6. Tích hợp bản đồ, sơ đồ HK 

II.6.1. Chèn sơ đồ tùy chỉnh 

Bước 1: Bấm vào vị trí trong tài liệu nơi sơ đồ sẽ được chèn 

Bước 2: Chọn eAIP> Charts> Insert hoặc eAIP > Charts > Insert Data from 

ACM để chèn sơ đồ từ module eACM (Hộp thoại ACM Explorer sẽ mở ra) 

 

 

Bước 3: Chọn và xác nhận sơ đồ mong muốn 
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Ghi chú: 

- Trong khi chèn, hệ thống sẽ nhắc người dùng chọn xem có nên chèn sơ đồ 

dưới dạng sơ đồ Tùy chỉnh hay không “THIS IS A CUSTOMCHART”. 

- Sơ đồ tùy chỉnh lớn hơn A3 phải luôn được chèn trong tệp riêng biệt. Nếu 

không có thể khiến trình tạo khung thu nhỏ sơ đồ vì nó sẽ không vừa với kích 

thước trang thông thường. 
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Bước 4: Người dùng có thể nhìn thấy hoặc được thông báo rằng sơ đồ đã được 

chèn thành công. Các phần của sơ đồ với ĐỒ HỌA bên trong xuất hiện trong 

Structure View. 

II.6.2. Xóa sơ đồ tùy chỉnh 

Bước 1: Chọn thành phần Sơ đồ trong cửa sổ dạng Structure view 

Bước 2: Nhấp vào phím Delete, sơ đồ tùy chỉnh đã chọn sẽ bị xóa và tệp sơ đồ 

tùy chỉnh tương ứng sẽ bị xóa khỏi cơ sở dữ liệu. 

II.6.3. Tạo danh sách các sơ đồ sân bay 

Bước 1: Mở tệp chứa các sơ đồ sân bay 

Bước 2: Chọn mục menu eAIP > Finalization > Generate > Chart List 

Bước 3: Hệ thống sẽ tạo trước các danh mục sơ đồ của tất cả các sân bay đã 

được liệt kê từ phần AD của tài liệu. 

II.7. Quản lý sản phẩm 

Để hiển thị Quản lý sản phẩm, rất nhiều thuộc tính đã được cung cấp bởi eAIP. 

Menu “FILE” là menu đầu tiên cung cấp các thuộc tính có thể được sử dụng để 

quản lý sản phẩm. 

II.7.1. Menu FILE (sản phẩm) 
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II.7.2. Menu File (tài liệu) 

 

Bước 1: Chọn eAIP > File > Open và cửa sổ lựa chọn để mở thuộc tính sản phẩm 
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Bước 2: Kích hoạt tab Book 

Bước 3: Xác định tiêu chí lọc sử dụng các lệnh Publications, Editions, Listed 

Editions 

Bước 4: Chọn sản phẩm được yêu cầu trong danh sách các phiên bản sản phẩm 

có thể truy cập ở phần dưới cùng của cửa sổ Open 

Bước 5: Nhấp vào nút OK. 

Ghi chú: Hệ thống cho phép mở đồng thời nhiều hơn 1 phiên bản sản phẩm. Tuy 

nhiên, chỉ 1 phiên bản được mở để biên soạn, các phiên bản khác được mở ở chế 

độ read-only. 

 

Cửa sổ Open có chứa các thành phần lệnh sau để chọn sản phẩm:  

a) Thành phần lệnh “Publications” để lọc tài liệu dựa trên loại sản phẩm đã được 

lựa chọn (vd: AIP, ADMT hoặc AIRAC) 

 

b) Thành phần lệnh “Edition” để lọc tài liệu dựa trên loại sản phẩm đã được lựa 

chọn. 

 

c) Thành phần lệnh “Listed Editions” để lọc tài liệu dựa trên trạng thái của nó.  
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II.8. Quản lý tài liệu 

II.8.1. Đánh dấu văn bản 

Thẻ eAIP.wiz@rd có chức năng cài sẵn cho cấu hình đánh dấu văn bản. Hệ thống 

cho phép phân biệt dữ liệu bằng các màu xác định trước:  

- Dữ liệu thay đổi (màu đỏ); 

- Dữ liệu tĩnh (màu xanh da trời); 

- Dữ liệu tĩnh đã thay đổi (màu xanh lá) 

II.8.2. Đánh dấu các thay đổi: Chọn eAIP > Changes > Highlight Changes (Lưu 

ý rằng chức năng này chỉ áp dụng cho tiểu mục không ở chế độ read only). 

II.8.3. Highlight dữ liệu tĩnh: Chọn eAIP > Static Data > Highlight Static Data. 

(Lưu ý rằng dữ liệu tĩnh đã được thay đổi có màu khác với dữ liệu tĩnh chưa được 

thay đổi.) 

II.9. Đăng tải sản phẩm lên Portal 

Tải sản phẩm dạng HTML được tạo bởi eAIP và Eurocontrol eAIP-pack lên 

Portal.  

Chọn eAIP > File > Export > Upload HTML Publication. 

Ghi chú: 

- Sản phẩm phải được khóa. 

- Thư mục xuất phải hiển thị, nội dung không được kiểm tra tính đầy đủ hoặc hiệu 

lực. Toàn bộ sản phẩm phải được xuất bằng cách eAIP > File > Export > 

Publication in eAIP XML/HTML và tệp HTML phải được tạo. 

- Chỉ cho phép tải lên 1 tệp cho 1 ngày hiệu lực đồng thời. Không được phép tải 

lại nếu version Portal đã có các sửa đổi được sử dụng trong các yêu cầu thay đổi. 

III. Các kỹ năng biên soạn sản phẩm 

Phần dưới đây miêu tả một số kỹ năng biên soạn các phần cơ bản của eAIP. Để 

biên soạn các sản phẩm điện tử khác như eSUP, eAIC, nhân viên Phòng AIP sử 

dụng các kỹ năng tương tự. 
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III.1. Hoàn tác về Bản chỉnh sửa 

Có thể hoàn tác phiên bản cuối cùng của tài liệu về phiên bản trước đó. Chức 

năng này có thể sử dụng khi tiểu mục được mở. Có thể được sử dụng khi có các 

lỗi được phát hiện trong tiểu mục và cần sử dụng 1 số phiên bản trước đó của tiểu 

mục. 

Bước 1: Chọn eAIP > File > Revert (Hiển thị hộp thoại Select Revision) 

 

Bước 2: Chọn phiên bản mong muốn (Nhấp nút preview để xem phiên bản 

mong muốn sẽ hiển thị như thế nào.) 

 

Bước 3: Nhấp Revert 

Bước 4: Xác nhận thay đổi. 



TÀI LIỆU HƯỚNG DẪN KHAI THÁC CƠ SỞ AIP  

Phần Phụ lục 

 

 PL - 29 11/12/2023 

 

Bước 5: Hoàn thành 

 

III.2. Chèn dữ liệu tĩnh 

Bước 1: Nhấp vào vị trí trong tài liệu nơi bạn muốn chèn dữ liệu tĩnh. 

Bước 2: Chọn eAIP > Static Data > Insert from SDO (Cửa sổ hộp thoại SDO 

Explorer mở ra) 

Bước 3: Chọn loại dữ liệu mà bạn cần chèn. Màu của ô sẽ được chuyển sang màu 

vàng cho biết lựa chọn của bạn. 

 

Bước 4: Nhấp vào biểu tượng Confirm trong menu 
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Bước 5: Cửa sổ Select CD to insert sẽ mở ra 

 

III.3. Chọn dữ liệu tĩnh 

Bước 1: Nhấp vào vị trí trong tài liệu nơi bạn muốn chèn dữ liệu tĩnh. 

Bước 2: Chọn eAIP > Static Data > Select from SDO (Cửa sổ hộp thoại SDO 

Explorer mở ra) 

Bước 3: Chọn dữ liệu bằng cách nhấp vào tất cả các ô thuộc tính trong cửa sổ 

chi tiết của tính năng hàng không sẽ được sử dụng. Màu của ô sẽ được chuyển 

sang màu vàng cho biết lựa chọn của bạn. Có thể thực hiện nhiều lựa chọn bằng 

cách nhấp vào các thuộc tính mong muốn. 

Bước 4: Nhấp vào biểu tượng Confirm trong menu 

Bước 5: Cửa sổ Select CD to insert sẽ mở ra 

III.4. Chèn/cập nhật mẫu 

Bước 1: Chọn vị trí / tiểu mục nơi bạn muốn chèn mẫu 

Bước 2: Chọn eAIP > Template Generator > Insert/Update Template. Cửa 

sổ Select template sẽ mở ra. 
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Bước 3: Xác nhận bằng cách nhấp vào biểu tượng OK để chèn mẫu 
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III.5. Thay đổi thủ công 

Việc cập nhật này sẽ đảm bảo giữ được các thay đổi của người dùng trong cấu 

trúc được tạo tự động trong suốt quá trình cập nhật mẫu mới (văn bản này phải 

nằm trong thành phần đặc biệt, gọi là ChangeTG). 

Chọn AIP > Template Generator > Mark as Manual Change 

 

Ghi chú: Thay đổi thủ công được bao bọc bởi thành phần ChangeTG chỉ khi thay 

đổi thủ công này chỉ là một phần của nội dung một ô, không phải tất cả chúng. 

III.6. Đặt Change Bars tự động 

Bước 1: Chọn mục menu eAIP > Changes > Auto Place Change Bars 

Bước 2: Cửa sổ hộp thoại AIP Tree sẽ mở. Chọn các phần của tập AIP bạn 

muốn áp dụng chức năng Place Change Bar và xác nhận lựa chọn của bạn 

bằng cách nhấp nút OK 
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Bước 3: Cửa sổ hộp thoại Place changebars sẽ được hiển thị. (Người biên soạn 

có thể chọn các thao tác trong hộp thoại này bằng cách tích vào chúng) 

 

III.7. Đặt Change Bars thủ công 

Bước 1: Nhấp vào vị trí trong tài liệu nơi bạn muốn chèn change bar 

Bước 2: Chọn mục menu eAIP > Changes > Manual Place Change Bars 

  Cửa sổ hộp thoại Place changebars sẽ được hiển thị nơi bạn chọn loại và vị 

trí của change bar (Người biên soạn có thể chọn loại và vị trí của change bar 

bằng cách nhấp vào chúng) 
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III.8. Thêm Blank Page (trang trống) 

Chọn menu eAIP > Tools > Add Blank Page cho phép thêm một trang có chủ ý 

để đạt được định dạng yêu cầu tài liệu trang gấp đôi trong AIP (số trang là số 

chẵn). 

Chỉ định số trang của một tài liệu nhất định sẽ đứng trước trang trống được chèn 

vào. 

 

Lưu ý: Trang trống có chủ ý sẽ trống hoặc có văn bản “"INTENTIONALLY 

BLANK" theo cấu hình. 

III.9. Xóa Blank Page (trang trống) 

Chọn menu eAIP > Tools > Remove Blank Page bạn có thể bắt đầu lựa chọn 

trang được chỉ định để xoá. Bạn sẽ được yêu cầu chỉ định số trang được yêu cầu.  

 

Lưu ý: Trong trường hợp trang được chỉ định không trống, hệ thống sẽ cảnh 

báo bạn và trang được chỉ định sẽ không bị xoá. 
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Phụ lục 4: Mẫu các sản phẩm TBTTHK của Hệ thống AIM 

 

 

Mẫu Tập bổ sung AIP Việt Nam thông thường (Hệ thống AIM) 
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Mẫu Tập bổ sung AIP Việt Nam theo chu kỳ AIRAC (Hệ thống AIM)  
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Phụ lục 5 

Danh mục các văn bản hiệp đồng liên quan 

- Các văn bản hiệp đồng (VBHĐ) quốc tế: 

+ VBHĐ về phương thức trao đổi tin tức và dữ liệu hàng không giữa Trung tâm 

TBTTHK và Ban tiêu chuẩn an toàn và khai thác bay - Cục HK Campuchia; 

+ VBHĐ trao đổi, cung cấp tin tức/sản phẩm hàng không giữa Trung tâm TBTTHK 

và Jeppesen. 

- Các VBHĐ trong nước: 

+ VBHĐ bảo đảm dịch vụ TBTTHK giữa TCT Quản lý bay VN và TCT Cảng 

HKVN - CTCP; 

+ VBHĐ bảo đảm dịch vụ tại Cảng HKQT Nội Bài giữa Trung tâm TBTTHK và 

Cảng HKQT Nội Bài; 

+ VBHĐ bảo đảm dịch vụ tại Cảng HKQT Đà Nẵng giữa Trung tâm TBTTHK và 

Cảng HKQT Đà Nẵng; 

+ VBHĐ bảo đảm dịch vụ tại Cảng HKQT Tân Sơn Nhất giữa Trung tâm TBTTHK 

và Cảng HKQT Tân Sơn Nhất; 

+  VBHĐ bảo đảm dịch vụ tại Cảng HKQT Cam Ranh giữa Trung tâm TBTTHK 

và Cảng HKQT Cam Ranh; 

+ VBHĐ bảo đảm dịch vụ giữa Trung tâm TBTTHK và Cảng HKQT Vân Đồn; 

+ VBHĐ bảo đảm dịch vụ TBTTHK giữa Trung tâm TBTTHK và Công ty TNHH 

Kỹ thuật QLB; 

+ VBHĐ trao đổi, cung cấp TTHK và phối hợp về điện văn không lưu giữa Công 

ty QLB miền Bắc và Trung tâm TBTTHK; 

+ VBHĐ bảo đảm kỹ thuật giữa Công ty QLB miền Bắc và Trung tâm TBTTHK;  

+ VBHĐ bảo đảm dịch vụ giữa Công ty QLB miền Trung và Trung tâm TBTTHK; 

+ VBHĐ bảo đảm dịch vụ giữa Công ty QLB miền Nam và Trung tâm TBTTHK; 

+ VBHĐ bảo đảm dịch vụ giữa Trung tâm TBTTHK và Trung tâm Quản lý luồng 

không lưu; 

+ VBHĐ bảo đảm dịch vụ giữa Trung tâm Khí tượng hàng không và Trung tâm 

TBTTHK. 

 

 

 

 


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-06T13:21:32+0700
	BỘ GIAO THÔNG VẬN TẢI
	Nguyễn Thế Hưng<hungand@caa.gov.vn> đã ký lên văn bản này!


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-06T13:21:39+0700
	BỘ GIAO THÔNG VẬN TẢI
	Nguyễn Thế Hưng<hungand@caa.gov.vn> đã ký lên văn bản này!


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-06T13:21:48+0700
	BỘ GIAO THÔNG VẬN TẢI
	Nguyễn Thế Hưng<hungand@caa.gov.vn> đã ký lên văn bản này!


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-06T13:21:58+0700
	BỘ GIAO THÔNG VẬN TẢI
	Nguyễn Thế Hưng<hungand@caa.gov.vn> đã ký lên văn bản này!


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-07T10:11:41+0700
	BỘ GIAO THÔNG VẬN TẢI
	Hồ Minh Tấn<hmtan@caa.gov.vn> đã ký lên văn bản này!


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-07T14:40:27+0700
	BỘ GIAO THÔNG VẬN TẢI
	CỤC HÀNG KHÔNG VIỆT NAM<caav@caa.gov.vn> đã ký lên văn bản này!


		Bộ Giao thông vận tải - Phone: 02438222979 - Fax: 02438221066 - Email: tic@mt.gov.vn
	2023-12-07T14:40:36+0700
	BỘ GIAO THÔNG VẬN TẢI
	CỤC HÀNG KHÔNG VIỆT NAM<caav@caa.gov.vn> đã ký lên văn bản này!




